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How to Print Wiring Diagram Pages

Many of the original Ford wiring manuals were created in a very large format (11x17, 17x24, and 17x36)
making it difficult to print on a standard home printer. Some printers will print only a portion of the entire
page, while others will shrink the page into an unreadable format. However, Adobe Reader has the ability
to print sections (known as Tiles) of the page onto standard 8.5x11 paper. Please use the steps below to
print these wiring diagrams.

You can print a large format document, such as these wiring
diagrams, by splitting the page across multiple sheets of paper (called
"tiling™). The tiling option calculates how many sheets of paper are
needed. You can adjust the size of the original to best fit the paper and
specify how much each "tile™ overlaps. You can then piece together
the tiles.

1. Choose File > Print.

2. From the Page Scaling pop-up menu, select one of the following options:
Tile Large Pages Tile only the pages that are Iarger than the paper.

Tile All Pages Tile all the pages in the PDF
file.

- N v Ihres Jaae 0% Pages B

Curert e

Note: If the tile options are not in the menu, make 2
sure that the following options are not selected in '
the Advanced Print dialog box: Print As Image or, ——— =S

for Acrobat only, Separations or In-RIP N
Separations. Also check your version of Reader. | e st [ e g e

Reader 9 does not support tiling. T -

-

3. Set the following options as needed:
Tile Scale Scales the pages by the amount

you specify.
Overlap Determines the amount each tile overlaps adjacent tiles.
Cut Marks Adds guide marks to each page to help you trim the overlap.

Labels Adds the filename and page number on each "tile".

— = — Cut Marks show where to trim pages.

4. Click OK gives you space to adhere
: the pages together without covering
or Print. a portion of the image.

Labels indicate which portion of the

document is represented on a page
A to help you assemble the poster or
banner in the proper order.

@)




How to Print a Portion of a Wiring Diagram

You can print a portion of a page in a PDF. The
Snapshot Tool lets you select just the area you want
to print. The area can be text, graphics, or both. You
can print the selected area full size or resize it to fit
the paper.

1. Open the PDF in Adobe Reader or Adobe Acrobat.

2. (Acrobat X/Reader X) Choose
Edit > Take A Snapshot.
(Acrobat 9/Reader 9) Choose
Tools > Select & Zoom >
Snapshot Tool.

3. Drag a rectangle around the
area you want to print.

4. Choose File > Print.

5. Make sure that the Selected
Graphic option is selected in the
Print Range area of the Print
dialog box.

it Range
o

C(© Selected graphe
O Curvent page

I

| (S 8s

6. (Optional) To enlarge the

selected text or graphic to fit the
sheet of paper, choose Fit To

. Page Hardng /_‘__N/ g : .4
Printable Area from the Page e L S K, Q@
Scaling pop-up menu. rage s [P ea o | N

_ : P —— | e

Note._EnIarglng the area reduces i = N -
the printed resolution. w 9
[(ermt to Be —

7. Click OK or Print.
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How to Print a Portion of a Wiring Diagram

I esnians Wire Cotor Code |

P FiE0-158 Bovies =55
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o

Print Current View

21t resize it to fit

You can print just the current zoom-in

" viewofa page in a PDF. The print
_ Current View lets you print just the
,1="  current view seen on the screen. The

area can be text, graphics, or both. You
can print the selected area full size or

the paper.

Open the PDF in Adobe Reader or Adobe Acrobat.
Zoom into the portion of the diagram you want to print.

Choose File > Print.

Make sure the Current
View option is selected
in the Pages to Print
area of the Print dialog
box.

Note — To select
Current view, you may
need to click the “More
Options” dropdown.

(Optional) To enlarge
the selected text or
graphic to fit the sheet
of paper, choose Fit To
Printable Area from the
Page Scaling pop-up
menu.

Print

Brinter. | Xerox Phaser 8560DN PS

VH Properties || Advanced |

Copies: |1 -
Pages to Print
) All

_) Current page

Pages |16
¥ More Options

@ Current view
All pages in range
Reverse pages

Page Sizing & Handling (%)

l [ 5 size ” A5 Poster l [B) Muttiple

@ Fit
) Actual size

_) Shrink oversized pages
Custom Scale: 100 o
[] Choose paper source by PDF page size
[ Print on both sides of paper

Crientation:
@ Auto portrait/landscape
_) Portrait

") Landscape

Page Setup...

|| Print in grayscale (black and white)

Comments & Forms

‘ Decument and Markups

| Summarize Comments |

Scale: 125%

8.5x11 Inches

[E] Booklet
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Pagel of1 (16)

Print | Cancel ‘

Note: Enlarging the area reduces the printed resolution.

6. Click OK or Print.
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The illustrations contained in this book were in effect at the time the book was approved for printing. Ford Motor Companies, whose
poticy is one of continuous improvement, reserves the right to discontinue models at any time, or to change specifications or design,
without notice and without incurring obligations.

INDEX

An INDEX is provided behind the divider for each
truck series. The index page contains an al-
phabetically arranged list of systems and compo-
nents and a bulb usage list. The index lists the
location of the components on the drawing. Ex-
a’Tples of the two types of index references are
shown:

A. To locate an electrical part at D-49, find the
location number 49 at the top of the illustra-
tion. Then, find the letter D on the side of the
illustration. Follow the number and the let-
ter until the lines intersect. The part will be
within an ineh or two of the intersection.

B. To locate an electrical part at PG3-D10, turn
to page 3 as indicated in the lower right
corner of the sheet. Then, find the number
10 at the top of the illustration and the letter
D on the side of the illustration. Follow the
number and the letter until the lines inter-
sect. The part will be within aninch or two of
the intersecting lines.

BASIC INFORMATION

Generally, the power supply for all components
on this drawing comes from the top of the page
and over to the battery at the left.

The ground for each component is always toward
#he bottom of the drawing that are explained as
ollows:

e Ground symbols are shown in Figure 1. A
ground wire connected away from the com-
ponent is indentified by a code G1 or G2, etc.
The location of the remote ground is listed in
the GROUND CODES chart and the botton of
the page.

= Lo

Fig. 1 — Ground Symbols

e Wire color code is shown in Figure 2. Wire
color codes (by color) are listed on page-4.

640 (Red-Yellow Hash)

Fig. 2 — Wire Color Code

If a vehicle specific wire color in a connector does
not match the diagram shown, it can usually be
identified by comparing the other colors shown at
the wire connectors. Specific wire color devia-
tions in the manufacturing of a wire harness are
usually for a short duration.

HOW TO USE THE WIRING DIAGRAMS

e Harness number is shown in Figure 3. The 5
or 6 digit number near the wire indicates the
wire harness basic part number.

14290

wris (@) Oy
@ @

Fig. 3 — Harness Number

e Wire connector identification code is shown
in Figure 4. The key for the connector codes is
located at the bottom of the wiring diagram.

NN
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Cc22
Fig. 4 — Wire Connector Code

e Male connector symbol isillustrated in Figure
5. The symbol used for the diagram and chart
is shown.

IAGRAM
DIAGR CHART
Fig. 5 — Male Connector Codes

e Female connector symbol is shown in Figure
6.

— O

DIAGRAM CHART
Fig. 6 — Female Connector Codes

e Splice is shown in Figure 7. A splice is a
common point where two wires are joined
together. Location of splice is at bottom of
schematic page.

Fig. 7 — Splices

e Heavy lines for the wires indicate a direct to
battery feed.

e Heavy dashed lines indicate an ignition
switch accessory feed.

Electrical symbols used in the schematics are il-
lustrated and described on the next page.



2 = ATERMINAL CONNECTION

\ = AFEMALE TERMINAL

A = AMALE TERMINAL

O = A GRAPHIC FEMALE ROUND TERMINAL.
AND/OR A SWITCH CONTACT. AND/OR
ASTUD ON A COMPONENT.

@ = A GRAPHICS MALE TERMINAL (STD.)

@ - ASPLICE. AND/OR A CHASSIS
CONNECTION. AND/OR A GRAPHICS

EMPTY CONNECTOR CAVITY FOR
A STANDARD ROUND PIN TERMINAL.

(O = AGRAPHICS BIG FEMALE TERMINAL

@ A GRAPHICS BIG MALE TERMINAL

@ - A GRAPHICS EMPTY CONNECTOR CAVITY
FOR A BIG ROUND TERMINAL.

U = A GRAPHICS ARCLESS FEMALE TERMINAL
B = A GRAPHICS ARCLESS MALE TERMINAL

l = A GRAPHICS EMPTY CONNECTOR CAVITY
FOR ARCLESS TERMINALS.

S . A WIRE TERMINATION

Q. - AN EYELET TERMINAL GROUND
£ . AcHASSIS GROUND
]
6' = ASINGLE EYELET CONNECTION
P - AN EYELET CONNECTION TO A STUD.
& OR A SERIES OF EYELET CONNECTIONS.
7 % =WIRE SHIELD
Lo

SPLICED WIRES SHALL BE REPRESENTED BY:

T
297
BK-LGH s-201
297 BK-LGH 297 BK-LGH — 10 REDUCE DRAWING CLUTTER, THE SPLICE SYMBOL MAY BE EXPANDED
257 BEYOND THE SINGLE BLACK DOT, AS SHOWN BELOW.
BK-LG H SPLICE
L SYMBOL
WHILE: SPLICE SYMBOL SHOWN TWICE.
: BUT IT IS ACTUALLY ONE
; NO SPLICE SYMBOL SPLICE IN THE WIRING.
W-LB
——1D8 —1DB——5§ 201 37 Y——
2 ——37Y $-201 IIY——
W-LB $-201
Iy IY—
7
Y
THESE WIRES SIMPLY PASS L L

EACH OTHER, AND ARE NOT
CONNECTED ELECTRICALLY.

" 8

=JUNCTION BLOCKS g
1= SINGLE TERMINAL g

2 = DOUBLE TERMINAL

3= DOUBLE TERMINAL
WITH BUSS BAR

= MOMENTARY SWITCH CONTACT
= DISTRIBUTOR SWITCH CONTACT

)
= A FIXED RESISTANCE g

= BREAK BEFORE MAKE SWITCH WIPER
(THREE OR MORE POSITIONS)

= MAKE BEFORE BREAK SWITCH WIPER
(THREE OR LESS POSITIONS)

=HINGED PALL SWITCH WIPER
(THREE OR LESS POSITIONS)

= A PUSH OR PULL SWITCH WIPER

= A VARIABLE RESISTANCE
=A THERMISTOR

= APOTENTIOMETER OR A *
RHEOSTAT. DEPENDING ON
EXTERNAL CIRCUITY. *—

]

= A FIXED CAPACITOR

=A VARIABLE CAPACITOR

=A HEATER AND/OR TEMPERATURE
SENSITIVE ELEMENT

e N e NI T 0 00 <0 )y, (50 [O0]

®
®

SPLICE IDENTIFICATION

gl

ELECTRICAL SYMBOLS

=VARIOUS SIZE FUSES
(USED WITH FUSE PANELS)

= AN INLINE FUSE & HOLDER

= A CIRCUIT BREAKER
(FUSE PANEL MOUNTED)
(SELF RE-SETTABLE)

= A CIRCUIT BREAKER

(FUSE PANEL MOUNTED)
(MANUALLY RE-SETTABLE)

= AN INLINE CIRCUIT BREAKER
(SELF RE-SETTABLE)

=A COIL AND/OR INDUCTOR
(W/O IRON CORE}

=A COIL AND/OR INDUCTOR
(WITH IRON CORE)

= A DIODE

A SILICON CONTROL RECTIFIER

= A ZENER DIODE

= AN INLINE DIODE

=A TRANSISTOR (PNP)

=A TRANSISTOR (NPN)

SPLICE IDENTIFICATION
IN WIRE SYMBOL INDICATES

THIS PRACTICE.

MISCELLANEOUS COMPONENTS]

COMPONENT SYMBOLS
RELAYS

o

! = A RELAY

= A BATTERY
a2voLT)

= A RELAY

= A SINGLE FILAMENT BUL

@

(SINGLE POLE. SINGLE THROW.
NORMALLY OPEN)

(SINGLE POLE. SINGLE THROW.

(W/0 GROUND) NORMALLY CLOSED)
MAJOR FILAMENT
MINOR FILAMENT

= A RELAY

= A DUAL FILAMENT BULB >
(W/0 GROUND) i
'

@ = A HIGH BEAM HEADLAMF

Q = A MERCURY SWITCH
@ = ACLOCK

@ = AMETER (GAUGE)
m = A HORN

S

= A RELAY

= A CIGAR LIGHTER

=A BUZZER

[El = A SPEAKER

= A SWITCH (PUSH TO CLOSE)
(TWO CONTACT. NORMALLY OPEN}

= A SWITCH (PULL 7O CLOSE)
(TWO CONTACT. NORMALLY OPEN)

= A SWITCH (PULL TO OPEN)
(TWO CONTACT. NORMALLY CLOSED)

= A SWITCH (PUSH TO OPEN)
(TWO CONTACT. NORMALLY CLOSED)

o
i
3

= A SWITCH (PULL TO CLOSE)
{THREE CONTACT. NORMALLY OPEN)

= A SWITCH (PUSH TO CLOSE)
|—| (TWO CONTACT. NORMALLY OPEN.
MOMENTARY)

= A SWITCH (PULL TO CLOSE)
‘—| (TWO CONTACT. NORMALLY OPEN.

MOMENTARY)

(SINGLE POLE. DOUBLE THROW.
ONE CONTACT NORMALLY CLOSED)

(DOUBLE POLE. SINGLE THROW.
NORMALLY OPEN)

= A RELAY
(DOUBLE POLE. DOUBLE THROW
ONE CONTACT - EACH POLE
NORMALLY CLOSED)

=A SWITCH -
(SINGLE POLE. SINGLE THROW.
NORMALLY OPEN)

NORMALLY OPEN. TEMPERATURE
SENSITIVE)

= A SWITCH
6_3 (SINGLE POLE. SINGLE THROW.
Q

o]
g

[&] = aswitch
(SINGLE POLE. SINGLE THROW.
NORMALLY CLOSED)

= A SWITCH
(SINGLE POLE. SINGLE THROW.

A SWITCH

(SINGLE POLE. DOUBLE THROW.
ONE CONTACT NORMALLY CLOSED.
ONE CONTACT MOMENTARY)

= A SWITCH
(DOUBLE POLE. DOUBLE THROW.
NORMALLY CLOSED. GANGED.
TEMPERATURE SENSITIVE)

A SWITCH
(DOUBLE POLE. DOUBLE THROW.
NORMALLY OPEN. GANGED)

NORMALLY OPEN. MOMENTARY)

= A SWITCH
(DOUBLE POLE. DOUBLE
THROW. ONE CONTACT EACH
POLE — NORMALLY CLOSED.

{SINGLE POLE. DOUBLE THROW.

GANGED)

CENTER NORMALLY OPEN)

%- A SWITCH ?

= A SWITCH
(SINGLE POLE. DOUBLE THROW hd

= A SWITCH
(DOUBLE POLE. DOUBLE THROW.
ONE CONTACT EACH POLE -
NORMALLY CLOSED. ONE

ONE CONTACT NORMALLY CLOSED)

O

= A SWITCH
{SINGLE POLE. DOUBLE THROW.
CENTER NORMALLY OPEN.
BOTH CONTACTS MOMENTARY)

(v

ONE COMMON DUAL CONTACT FOR EACH POLE —

COMMON DUAL CONTACT FOR
EACH POLE — MOMENTARY)

= A SWITCH
(DOUBLE POLE.
DOUBLE THROW.

NORMALLY CLOSED. TWO CONTACTS PER POLE
NORMALLY OPEN)

= A RELAY —
DOUBLE COIL @ - A SOLENOID
(SINGLE POLE.
oé)usu.e THREOW. (SINGLE) = A SOLENOID
ONE CONTACT {DUAL COIL — ONE COIL
NORMALLY CLOSED = A SOLENOID FOR “PULL-IN" AND
PER COILY (MULTIPLE) \A| one For“HoLOING")
MOMENTARY CONTACT
{MULTIPLE POSITION SWITCHES] \
= A SWITCH MAKE BEFORE Q} DASHED LINE
(SINGLE POLE. THREE POSITION. REAK WIPER INDICATION OF
dé? BREAK BEFORE MAKE WIPER) B ] GANGED WPERS
= ASWITCH
0,6 (SINGLE POLE. FOUR POSITION.
BREAK BEFORE MAKE WIPER)
909 MAKE BEFORE —— T
BREAK WIPER N
| = ASWITCH ] FUNCTIONAL TITLE
o (SINGLE POLE. THREE POSITION. 1
- BREAK BEFORE MAKE WIPER. 0, 0!
TEMPERATURE ACTIVATED) §
1
"
] SWITCH
= ASWITCH
(DOUBLE POLE. THREE POSITION. leggugmou § :g : POSITIONS
BREAK BEFORE MAKE WIPER. 1] s - sTaR?
GANGED) 4 R - RUN FUNCTIONS
: 0 - OFF OF SWITCH
- A swITCH L - Locx POSITIONS
— (DOUBLE POLE. THREE POSITION.
. D MAKE BEFORE BREAK WIPER.

TWO MOMENTARY CONTACTS PER

POLE. GANGED)

I:YPICAL IGNITION SWITCH




| vARIOUS MOTOR TYPES

[TYPICAL DISTRIBUTORS

COMPONENT TERMlNATIONSJ

ELECTRICAL 160 (CONSTANT DISTANCE — USED
% CONTINUITY TO INDICATE THAT TERMINALS
& L TO CASE ‘] ARE PART OF COMPONENT.)
N - 8R = A MCTQR
ax SOCKET TERMINALS ) SOCKET TERMINALS (SINGLE SPEED. UNIDIRECTIONAL) 4 CYLINDER / MALE TERMINAL
NOT SHOWN. INTEGRAL NOT SHOWN. INTEGRAL DISTRIBUTOR
.——-——- DASHED LINE INDIC
PART OF WIRE ASSEMBLY. PART OF WIRE ASSEMBLY. = N SART OF SAME comcggf'on
= H = A MOTOR — WITH BREAKER
(SINGLE SPEED. UNIDIRECTIONAL —4 W-BK —R——<
%::J:LAS g OR BIDIRECTIONAL DEPENDING a7y —s
ON EXTERNAL CIRCUITRY) 7
GROUND SOCKET HAS NO INTERNAL GROUND v A STUD -rEanNAL/ D a7v—s FEMALE TERMINAL
-lﬁ[ = A MOTOR /6‘__ 6 CYLINDER
. 1 (TWO SPEED. UNIDIRECTIONAL) 5 DISTRIBUTOR DASHED LINE
7ol L H = HIGH SPEED INDICATES NDICA
‘i_"L Lj. ¥ SOCKET TERMINALS ARE L L = LOW SPEED A CONNECTION : TES COLOR OF WiRE
SOCKET TERMINALS "/ SHOWN. TERMINALS ARE = EYELET TERMINALS PIGTAIL EXTENDING FROM
Z NOT SHOWN. INTEGRAL PART OF SOCKET. BUT - TO MATE WITH STUD COMPONENT. CIRCUIT NUMBER
PART OF WIRE ASSEMBLY. TERMINALS ON WIRE = A MOTOR TERMINAL ON COMPONENT.  AND/OR COLOR CODE MUST BE
) ASSEMBLY MATE (SINGLE SPEED. PROVIDED.
4 o SOCKET TERMINALS. BIDIRECTIONAL) 8 CYLINDER
DISTRIBUTOR
é_ L 351 AND 400
SOCKET HAS SOCKET HAS
NO INTERNAL NO INTERNAL
GROUND GROUND GROUND INDICATIONS
v A
» - A
«go_ _sh o SOCKET TERMINALS ARE — 6 CYLINDER
50 -X Ll r; O——| DISTRIBUTOR
oo wpe SHOWN. TERMINALS ARE uifl (BREAKERLESS) CONTINUITY BETWEEN THESE
PART OF SOCKET. BUT TYPICAL STARTER MOTOR N4 Y G201 TWO SYMBOLS INDICATED BY
@:) SOCKET TERMINALS % TERMINALS ON WIRE (FOUR POLE. UNIDIRECTIONAL) o O 57 BK —— POSITION OF SYMBOLS ON
NOT SHOWN. INTEGRAL ASSEMBLY MATE 7 =i COMPONENT OUTLINE (CHASSIS
PART OF WIRE ASSEMBLY. SOCKET TERMINALS. «
| TERMINALS AND CONNECTORS )
SOCKET HAS SOCKET HAS 8 CYLINDER
INTERNAL INTERNAL
GROUND GROUND AS USED ON THE DIAGRAMS. INDIVIDUAL TERMINALS DISTRIBUTOR EYELET GROUND CHASSIS GROUND
SHALL BE REPRESENTED BY: 351 AND 400 ELECTRICAL PATH TO GROUND ELECTRICAL PATH TO GROUND
(BREAKERLESS) PROVIDED BY ATTACHMENT OF CROVIDED WHEN COMPONENT
A.—> MALE EYELET TERMINAL TO VEHICLE
CHASSIS 1S INSTALLED.
T T ‘
T s 8.— FEMALE
LG Bx
S C. O EYELET
Hi BEAM S3) DUALBEAM TERMINALS PHYSICALLY LOCATED IN THE SAME CONNECTOR WIRE TYPES
HEADLAMP < HEADLAM SHELL MAY BE REPRESENTED SEPARATELY ON THE DIAGRAM. L.E. 1 TI LT T LILL
Y —> C-201
o c-202 & ca201 N ' 4 DIRECT BATTERY FEED PHOTO UNIT] | MODULATOR ASSEMBLY
ey foy OR DESIGNATED AS BEING IN THE SAME CONNECTOR SHELL. |.E. — § IGNITION SWITCH CONTROLLED FEED BREAKERLESS IGNITION
) 357 DASHED LINE INDICATES TERMINALS ARE AN 4 RESISTANCE WIRE
—_— IN SAME CONNECTOR SHELL. — ALL OTHER TYPICAL EXAMPLES OF COMPONENTS WITH
MATING TERMINALS ARE, THEREFORE, REPRESENTED AS: UNDEFINED INTERNALS.
AN 3
b P Ji ! USED IN CASES WHERE COMPONENTS ARE
1 s —
s awes so T et sooers. o — to el e ek e
AND ARE SHOWN AS ABOVE. .

TWO WIRES PHYSICALLY ATTACHED TO A SINGLE TERMINAL

ARE REPRESENTED BY:
7 OR 7

CIRCUITRY IS NOT CONSIDERED
NECESSARY FOR CLEAR UNDERSTANDING
OF ASSOCIATED WIRING AND COMPONENTS.



STANDARD WIRE COLOR CODE CHART

CIRCUIT DESCRIPTION
1 HORN SWITCH TO HORN RELAY
2 TURN SIGNAL SW. TO RH FRONT TURN SIGNAL LAMP
3  TURN SIGNAL SWITCH TO LH FRONT TURN SIGNAL LAMP
4 ALTERNATOR REG. “S” TERM. TO ALTERNATOR ““S"” TERM.
6 HORN RELAY TO HORN
8 IGNITION SWITCH TO TURN SIGNAL FLASHER
10  FUSE PANEL TO STOPLAMP SWITCH
11 HEADLAMP SWITCH TO PARKING LAMPS
12 HEADLAMP DIMMER SWITCH TO HIGH BEAMS
13 HEADLAMP DIMMER SWITCH TO LOW BEAMS
15 HEADLAMP SWITCH TO HEADLAMP DIMMER SWITCH
16 IGNITION SWITCH TO IGNITION COIL “BATT.” TERMINAL
17 LOW OIL PRESSURE WARNING LAMP TO LOW OIL PRESS.
SNDG. UNIT
18  AUX. CIRC. BREAKER TO GLOVE BOX LAMP
19 HEADLAMP SWITCH TO INSTRUMENT PANEL LAMPS
21  BATTERY TO IGNITION SWITCH FEED
22 BRAKE FEED
23 CIRCUIT BREAKER TO VOLT. DIVIDER
25 JUNCTION BLOCK TO HEADLAMP SWITCH
26 ALTERNATOR GROUND (NEG. TERM.)
27  WINDSHIELD WIPER CIRC. BRKR. TO W/S WIPER SWITCH
28 WINDSHIELD WIPER SW. TO WINDSHIELD WIPER MOTOR
30 IGN. SW. TO CONSTANT VOLTAGE UNIT & INDICATOR LAMPS
31 OIL PRESS. INDICATOR TO OIL PRESS. SENDING UNIT
32 IGNITION SWITCH TO STARTING MOTOR RELAY
33 BATTERY TO HORN RELAY
34 HEADLAMP DIMMER SW. TO HIGH BEAM INDICATOR LAMP
35 ALTERNATOR REGULATOR “F”” TERM. TO ALTERNATOR
36 ALTERNATOR REGULATOR TO RECTIFIER TERM.
37 LOAD TERM. OF AMMETER TO ALTERNATOR OUTPUT TERM.
38 LOAD THRU AMMETER TO BATTERY
STARTING MOTOR RELAY BATTERY TERM. TO ALT. “A” TERM.
39 TEMP. GAGE TO TEMP. SENDING UNIT
40 BATTERY TO CIGAR LIGHTER
41 WARNING LAMP FEED
42  SWITCH TO WARNING LAMP
43  IGN. TERM. OF IGN. SW. TO LOW AIR BUZZER
44  TURN SIGNAL FLASHER TO TURN SIGNAL SWITCH
45 HOT WATER TEMP. RELAY TO HOT WATER TEMP. SENDING UNIT
48  BLIND CIRCUIT TERMINATING IN HARNESS
49  TURN SIGN. SW. TO RIGHT TURN SIG. INDICATOR LAMP
50 TURN SIG. SW. TO LEFT TURN SIG. INDICATOR LAMP
53 COURTESY LAMP SWITCH TO COURTESY LAMP
54  FUSE PANEL TO COURTESY LAMP SWITCH
55 CARGO LAMP SW. TO CARGO LAMP
56  WINDSHIELD WIPER SW. TO WINDSHIELD WIPER MOTOR
57  GROUND CIRCUIT
58  WINDSHIELD WIPER SW. TO WINDSHIELD WIPER MOTOR
60 CONSTANT VOLTAGE UNIT TO GAGE
61  WINDSHIELD WIPER SW. TO WINDSHIELD WIPER MOTOR
63  WINDSHIELD WIPER SW. TO WINDSHIELD WIPER MOTOR
65  WINDSHIELD WIPER SW. TO WINDSHIELD WIPER MOTOR
66  AIR SHIFT SWITCH TO DASH LAMP
67  STOP LAMP SW. TO INDICATOR LAMP
68 DEFROSTER MOTOR (FEED) TO IGN. SW. ACC. TERM.

COLOR

BLUE-YELLOW STRIPE
WHITE-BLUE STRIPE
GREEN-WHITE STRIPE
WHITE-BLACK STRIPE
YELLOW-GREEN STRIPE
ORANGE-YELLOW STRIPE
GREEN-RED STRIPE
BLACK-YELLOW STRIPE
GREEN-BLACK STRIPE
RED-BLACK STRIPE
RED-YELLOW STRIPE
RED-GREEN STRIPE

WHITE

BLACK-BLUE STRIPE
BLUE-RED STRIPE
YELLOW

BLUE-BLACK STRIPE
ORANGE
BLACK-ORANGE STRIPE
BLACK-RED STRIPE
RED

BLACK-WHITE STRIPE
BLACK-GREEN STRIPE
WHITE-RED STRIPE
RED-BLUE STRIPE
YELLOW
GREEN-BLACK STRIPE
ORANGE
YELLOW-BLACK STRIPE
BLACK-YELLOW STRIPE

BLACK-RED STRIPE
RED-WHITE STRIPE
BLUE-WHITE STRIPE
BLACK-YELLOW STRIPE
RED-WHITE STRIPE
ORANGE-BLUE STRIPE
BLUE

YELLOW-RED STRIPE
BLACK

WHITE—BLUE STRIPE
GREEN-WHITE STRIPE
BLACK-BLUE STRIPE
GREEN-YELLOW STRIPE
BLACK-RED STRIPE
BLUE

BLACK

WHITE-ORANGE STRIPE
BLACK-WHITE STRIPE
YELLOW

RED

GREEN

BLUE

GREEN-WHITE STRIPE
ORANGE-BLACK STRIPE

CIRCUIT DESCRIPTION
69 COIL TERM. IGN. SW. TO FUEL SOLENOID
71 IGNITION SWITCH TO FUSE PANEL
72 ENGINE ALARM RELAY (OIL PRESSURE) TO IND. LAMP
73 LOW AIR BUZZER TO LOW AIR BUZZER SWITCH
74  RELAY “H” TERMINAL TO LAMP (WATER)
75 STARTING MOTOR RELAY TO SERIES PARALLEL SW.
(NO. 1 TERM.)
76 MARKER LAMP FEED (NON TRACTOR) TO AUX. CIRC. BREAKER
78 CIR.BREAKER TO RH & LH MARKER LAMPS
79 CONTROL RECTIFIER TO ALT. REG. “IGN.” TERM.
80 BATTERY TO ENGINE COMPARTMENT LAMP
81 THERMAL SW. TO BLOW MTR. CONTROL RELAY
83 HEADLAMP SW. (REAR LAMP) TO SPEEDOMETER LAMP
84  WINDSHIELD WIPER/WASHER SW. TO FUSE PANEL
87 IGNITION SW. ACCY. TERM. TO CIRC. BREAKER
88  INSTR. PANEL LAMP SWITCH FEED
89 GLOWPLUG TO GLOW PLUG SWITCH
90 AIR PRESSURE GAGE TO TRANSMITTER
92 ELECT. FUEL PUMP TO AUX. CIRC. BREAKER
93 STARTER SWITCH TO ELECT. FUEL PUMP
95 WINDSHIELD WIPER CONTROL SWITCH TO GROUND
96  WINDSHIELD WIPER CONTROL SW. TO W/S WIPER MOTOR GRND.
98  ““A” TERM. IGN. SW. TO ALT. REG. “IGN.” TERM.
99 CONTROL SWITCH TO IGNITION SWITCH
100 CONTROL SWITCH TO VOLTAGE REGULATOR
109 BATTERY TO STARTING MOTOR RELAY FEED
110 FUEL TANK SOLENOID VALVE TO AUX. CIRC. BREAKER
113 STARTING MOTOR TO STARTING MOTOR RELAY
118 HEATER RELAY TO HEATER CIRC. BREAKER
120 CIRCUIT BREAKER (POWER & CHARGING) TO FUSE PANEL
128 STARTING MOTOR RELAY TO STARTING MOTOR
129 GLOWPLUG C. B. TO GLOW PLUG SW.
130 ACCESSORY RELAY “ARM./TERM.” TO ACCY. TERM. OF
FUSE PANEL
132 MOTOR TO GROUND (2 SPEED AXLE)
136 TWO SPEED AXLE SWITCH TO TWO SPEED ADAPTOR
137 FUSE PANEL TO RADIO
139  IGN. SW. “ACC.” TERM. TO BATT. TERM. OF CIRCUIT BRKR.
140 BACK UP LAMP SWITCH TO BACK UP LAMP
141 TWO OR THREE SPD. AXLE SW. TO TWO OR THREE SPD.
AXLE MTR.
142 TWO OR THREE SPEED AXLE CIRCUIT BREAKER LOAD TERM.
TO TWO OR THREE SPEED AXLE TERMINAL
143 TWO OR THREE SPD. AXLE SW. TO TWO OR THREE SPD.
AXLE MTR.
144  CIRCUIT BRKR. LOAD TERM. TO NO. 142 SPLICE (2 SPEED
AXLE SHIFT)
145 SPEEDO. ADAPTOR TO NO. 141, NO. 146 SPLICE (2 SPEED
AXLE SHIFT)
146  SHIFT MOTOR TO NO. 141, NO. 145 SPLICE (2 SPEED
AXLE SHIFT)
147  SHIFT MOTOR TO NO. 143 SPLICE (2 SPEED AXLE SHIFT)
148 HEADLAMP SW. TO AUTO. TRANS. IND. LAMP
149  AUX. LAMP CIRCUIT BREAKER LAOD TERM. TO AUX. LAMP

150

FEED HEADLAMP SWITCH “C"” TERMINAL
BATTERY FEED TO FUSE PANEL

COLOR

RED-GREEN STRIPE
BLACK

GREEN
ORANGE-GREEN STRIPE
GREEN

GREEN-RED STRIPE
BLACK-GREEN STRIPE
BLUE-YELLOW STRIPE
GREEN-RED STRIPE
BLACK-WHITE STRIPE
BROWN

BLACK

RED

GREEN-ORANGE STRIPE
BLACK-WHITE STRIPE
ORANGE

GREEN-WHITE STRIPE
BLUE

BLUE-YELLOW STRIPE
WHITE

ORANGE-BLACK STRIPE
BLACK

BLACK

BLACK-RED STRIPE
YELLOW
BLACK-GREEN STRIPE
YELLOW-BLACK STRIPE
RED

BLACK

BLACK

GREEN

YELLOW

GREEN

BLACK
YELLOW-BLACK STRIPE
GREEN-YELLOW STRIPE
BLACK-RED STRIPE
BLACK

GREEN

RED

GREEN

BLACK

BLACK

RED

BLACK-BLUE STRIPE

YELLOW
RED



STANDARD WIRE COLOR CODE CHART (CONTINUED)

CIRCUIT DESCRIPTION

151  SPEED CONTROL ON-OFF SWITCH TO AMPLIFIER

152  ALT. OUTPUT “A’ TERM. TO VOLTAGE REG. “A” TERM.

153 STARTING MOTOR RELAY TO FLASHER

154  AIR TANK VALVE

156  AIR TANK VALVE FEED

158 KEY WARNING SWITCH TO BUZZER

159 DOOR JAMB SWITCH TO BUZZER

160 BUZZER TO WARNING INDICATOR RELAY

161  IGN. SW. (ACC. TERM.) TO EMERG. BRAKE WARNING LAMP

162 EMERG. BRAKE WARNING LAMP TO EMERG. BRAKE SWITCH

181  FUSE PANEL TO HEATER BLOWER MOTOR

182  AIR COND. CIRC. BRKR. (LOAD TERM) TO THERMOSTAT SW.

183  AIR COND. CIRC. BRKR. (LOAD TERM) TO A/C BLOWER
SW. FEED

184  AIR COND. SW. (LOW) TO AIR COND. BLOWER MOTOR

185  AIR COND. SW. (HIGH) TO AIR COND. BLOWER MOTOR

188 CIRCUIT BRKR. TO HEADLAMP SW. “BATT.” TERM.

189 TERM. BLOCK TO CIRCUIT BREAKER

190  IGNITION SW. ACCY. TERM. TO AIR COND. CIRCUIT BREAKER

195 EMERG. BRAKE SW. TO SIGNAL LAMP & RESISTOR GND.

196  ACCY. FEED FROM FUSE PANEL TO RELAY

197  AUX. ACCY. FEED FROM RELAY

198 BATT. TERM. OF STARTER SOLENOID TO RELAY

199 CIRCUIT BREAKER FEED

200 CIRCUIT BREAKER TO SPLICE

201  SPLICE TO HEADLAMP SWITCH

203 INTERIOR LAMP PICKUP BOX COVER

205 CIRC. BRKR. LOAD TERM. TO STOPLAMP WRNG. RELAY
ARM. TERM.

206 GROUND RETURN TO TOWING VEHICLE

207 MARKER LAMP SWITCH TO MARKER LAMPS

208 WATER TEMP. SW. (HOT) TO DELAY & CONTROL RELAY

209 STOPLAMP SW. TO RELAY

210  INDICATOR LAMP TO SWITCH

212 AUX. CIRC. FEED TO TRACTOR TRAILER PLUG

213  OIL LEVEL SENDER TO SIGNAL UNIT (LAMP)

214  SIGNAL UNIT (LAMP) TO TEMP. SIGNAL LAMP

215  SIGNAL UNIT (LAMP) TO FUEL SIGNAL RELAY

221 IGNITION SW. “ACCY. TERM’* TO HEATER TEMPERATURE
SW. FD.

222 TEMPERATURE CONTROL SW. TO HEATER MOTOR BLOWER SW.

230 EMISSION CONTROL VALVE TO SWITCH

231 “L"” TERM. VOLTAGE REG. TO ACCESSORY TERM. IGN. SW.

232 ELECTRONIC SW. TO IGN. COIL NEG. TERM.

233  WINDSHIELD WASHER MOTOR TO IGN. SW.

234  WINDSHIELD WASHER MOTOR TO IGN. SW.

235 ALTERNATOR RELAY TO ALTERNATOR REGULATOR

252 CIRCUIT BREAKER (LOAD) TO 3 SPEED AXLE SWITCH

253 INTERMEDIATE TERMINAL 3 SPEED AXLE SWITCH TO SOLENOID
VALVE FORWARD TANDEM

254 HIGH TERM. 3 SPEED AXLE SW. TO SOLE. VALVE RR. TANDEM

255 CIRCUIT BREAKER (LOAD) TO AXLE LOCKOUT DIFFERENTIAL

256 ACCESSORY TERM IGN. SW. TO 3 SPEED AXLE SWITCH

257  IGN. SW. “ACCY. TERM.” TO BLOWER MOTOR

258 EMERG. BRAKE WARNING LAMP TO EMERG. BRAKE SWITCH

259

IGN. SW. TO EMERG. BRAKE WARNING LAMP

COLOR

BLUE:BLACK STRIPE
YELLOW

RED-WHITE STRIPE
RED

BLUE

BLACK-WHITE STRIPE
RED

WHITE

GREEN

GREEN-RED STRIPE
ORANGE
BROWN-WHITE STRIPE

BROWN

RED

BLACK

BLACK
GREEN-YELLOW STRIPE
YELLOW

RED

RED

RED-BLUE STRIPE
BLACK

BLACK-ORANGE STRIPE
BLUE

BLUE-YELLOW STRIPE
WHITE-YELLOW STRIPE

GREEN

WHITE

BLACK

RED-WHITE STRIPE
YELLOW

BLUE

BLUE

RED

RED-BLACK STRIPE
YELLOW-BLACK STRIPE

BLUE

RED

BROWN-YELLOW STRIPE
YELLOW-BLACK STRIPE
GREEN-YELLOW STRIPE
GREEN

BLACK

YELLOW-BLACK STRIPE
GREEN

RED

BLACK

BLUE

GREEN

YELLOW

BLACK

BLACK-RED STRIPE

CIRCUIT DESCRIPTION

260 BLOWER MOTOR TO SWITCH — LO

261 BLOWER MOTOR TO SWITCH — HlI

262 STARTING MOTOR RELAY TO IGN. COIL “I” TERM.

263 CLICKER RELAY TERM. NO. 4 TO AIR VALVE ASSY.

264 CLICKER RELAY TERM. NO. 3 TO AIR VALVE ASSY.

265 CLICKER RELAY TERM. NO. 1 TO SPEED CONTROL BRAIN

266 BRAKE SW. TO CLICKER RELAY TERM. NO. 4

267 CONTROL HEAD MAKE READY SW. TO BRAKE SW.

268 HEATER SW. TO HEATER BLOWER MOTOR (LOW)

269 HEATER SW. TO HEATER BLOWER MOTOR (MEDIUM)

270 HEATER SW. TO HEATER BLOWER MOTOR (HIGH)

271 AIR COND. MASTER SW. TO “F” TERM. OF FAST IDLE
RELAY

272 NEUTRAL SWITCH TO “B” TERM. OF FAST IDLE RELAY

273  IGN. SWITCH TO FAST IDLE RELAY

274  FAST IDLE RELAY TO STARTING MOTOR RELAY

275  FAST IDLE RELAY “A"” TERM. TO FAST IDLE SOLENOID

276  STARTING MOTOR RELAY TO NEUTRAL SWITCH

277 BLOWER MOTOR TO SWITCH

280 COORDINATOR SW. TO WINDSHIELD WIPER MOTOR

281 COORDINATOR SW. TO WINDSHIELD WIPER MOTOR

282 TURN SIGNAL SW. TO RH REAR TURN SIGNAL LAMP

283 TURN SIGNAL SW. TO LH REAR TURN SIGNAL LAMP

284 BATTERY FEED TO STOPLAMP SWITCH

285 “R” TERMINAL HEADLAMP SWITCH TO REAR LAMPS

286 FUEL GAGE INDICATOR TO TANK SENDING UNIT

288 “R"” TERM. OF ALT. REG. TO ALT. “R"” TERM.

289  FAST IDLE RELAY “A” TERM. TO COMPRESSOR CLUTCH

292 REAR TERM. OF HEADLAMP SW. TO STORAGE COMPT. LAMP

296  FUSE PANEL ACCY. FEED TO SPLICE

297  IGN. SW. (ACCY. TERM) TO FUSE PANEL ACCY. FEED

331  WINDSHIELD WASHER SW. (FLOOR) TO W/SHIELD WIPER SW.

332 WINDSHIELD WASHER SW. FEED (FLR.) TO IGN. SW. ACCY.
TERM

345 RELAY NO. 1 TERM. TO POST. TERM. VOLT. REG.

346 RELAY NO. 2 TERM. TO BATT. TERM. START RELAY

347 THERMOSTATIC SW. TO CLUTCH

348 THERMOSTATIC SW. TO AIR COND. SW. SELECTOR TERM.

349 THERMOSTATIC SW. TO AIR COND. SW.

350 AIR COND. SW. “HI” TERM. TO CLUTCH RELAY "“BATT.”
TERM.

351 CLUTCH RELAY TO CLUTCH

358  IGN. SW. (ACCY. TERM) TO AIR COND. EVAPORATOR
MOTOR SW.

359 EVAPORATOR THERMOSTAT TO COMPRESSOR CLUTCH

360 SPEED CONTROL BRAKE SW. TO SPEED CONTROL IND. LAMP

364 ACCY. TERM. IGN. SW. (FUSE PANEL) TO BLWR. (COIL
TERM) MTR. RELAY

369 VACUUM SOLENOID TO TEMP. SW.

370  AIRSHIFT SW. TO BATT. TERM. OF IGN. SW.

371  BLOWER MOTOR RELAY (LOAD TERM) TO BLOWER MOTOR

373 BATTERY FEED TO CIRCUIT BREAKER (BATT. TERM)

374 STARTING MOTOR RELAY TO ENGINE USAGE INDICATOR

376 HORNBUTTON TO HORN

377 AUX. CIRCUIT BRKR. TO HORN BUTTON

383 EMERGENCY WARNING FLASHER FEED

COLOR

RED-BLACK STRIPE
ORANGE-BLACK STRIPE
BROWN

RED

BLUE

WHITE

YELLOW
BLACK-YELLOW STRIPE
RED-BLACK STRIPE
BLUE-RED STRIPE
BLACK-YELLOW STRIPE

BLUE

GREEN

YELLOW

RED

BLACK

YELLOW

GREEN

WHITE-GREEN STRIPE
BLUE-BLACK STRIPE
GREEN
YELLOW-BLACK STRIPE
RED

BROWN

ORANGE
WHITE-BLACK STRIPE
BLACK

WHITE

RED

BLACK-GREEN STRIPE
RED

YELLOW
GREEN-WHITE STRIPE
WHITE-GREEN STRIPE
BLACK

GREEN-WHITE STRIPE
BROWN

YELLOW
RED

YELLOW
BLACK-WHITE STRIPE
YELLOW-BLUE STRIPE

BLACK-GREEN STRIPE
BROWN

YELLOW

RED

YELLOW

RED

BLUE-YELLOW STRIPE
YELLOW-BLUE STRIPE
RED-WHITE STRIPE



CIRCUIT DESCRIPTION

384 FLASHER TO EMERGENCY WARNING LAMP

385 FLASHER TO EMERGENCY WARNING SWITCH

386 FLASHER TO EMERGENCY WARNING INDICATOR

388 AUX. CIRCUIT BREAKER FEED

399 FUSE PANEL TO HEATER BLOWER SWITCH

450  IGN. SW. TO SEAT BELT WARNING INDICATOR LAMP FEED

451 SEAT BELT WARNING LAMP TO SEAT BELT WARNING IND.
RELAY TERM. NO. 1

452  IGN. SW. TO SEAT BELT WARNING IND. RELAY TERM NO. 4

453  SEAT BELT WARNING IND. GRD. SW. TO S/B WRNG. IND.
RELAY TERM. NO. 2

454  IGN. SW. COIL TERM. TO CIRCUIT BREAKER

455 CIRCUIT BREAKER TO FUEL VALVE

460 BATTERY TO HORN SWITCH

469  IGN. SW. ACCY. TERM. TO SEAT BELT WARNING SWITCH

474  IGNITION SW. (ACCY.) TO STOPLAMP RELAY (BATT. TERM.)

475 STOPLAMP SW. TO STOPLAMP RELAY (COIL TERM.)

477 CIRCUIT BREAKER TO FOG LAMP SWITCH

478 FOG LAMP SWITCH TO FOG LAMP

480 HI LAMP FEED FROM HEADLAMP SWITCH TO FUSE PANEL

483 INHIBITOR SWITCH TO MAKE READY SWITCH

484 CLICKER RELAY TERM. NO. 1 TO RESUME SPEED SWITCH

489 EMERGENCY FLASHER SWITCH TO STOPLAMP RELAY

490 IGNITION SWITCH TO TRANSMISSION INDICATOR LAMP

491 CIRC. BREAKER (BATT. TERM) TO STOPLAMP RELAY
( BATT. TERM)

492 STOPLAMP RELAY (ARM TERM.) TO TURN SIGNAL SWITCH

509 AIR COND. CONDENSOR THERMAL SWITCH FEED

510 AIR COND. CONDENSOR THERMAL SW. TO BLOWER MOTOR

511  STOPLAMP SW. TO TURN SIGNAL SW.

512 SWITCH TO TRAILER AUX. LAMPS

513 CIRCUIT BREAKER TO STOPLAMP RELAY FEED

514 EMERGENCY WRNG. SW. TO EMERG. WRNG. RELAY COIL TERM.

515 HEATER RESISTOR TO BLOWER MOTOR (HI)

519  GLOW PLUG SW. TO LAMP (FEED)

520 SEAT BELT WARNING LAMP TO WARNING LAMP SWITCH

526 CIRCUIT BREAKER TO MARKER LAMP SW. FEED

532  IGNITION SWITCH TO VACUUM SWITCH

533 VACUUM SWITCH TO INDICATOR LAMP

536 BLOWER MOTOR RELAY (LOAD TERM) TO BLOWER MOTOR

537 COMPRESSOR TO CLUTCH

546 STARTER CONTROL TO INTERLOCK MODULE

560 SEAT BELT WRNG. TIMER TO L.F. RETRACTOR SWITCH

561 SEAT BELT WRNG. TIMER TO R.F. SEAT SENSOR

562 SENSOR SIGNAL TO AMPLIFIER

563 AUX. HEADLAMP SW. TO AUX. HD. LAMP RELAY

564 HEADLAMP SW. TO AUX. HEADLAMP RELAY

565 AUX. HEADLAMPS TO AUX. HD. LP. RELAY

568 ALTERNATOR RELAY TO ALTERNATOR REGULATOR

569 INTERLOCK MODULE TO CENTER BUCKLE SWITCH

570 INTERLOCK MODULE TO CENTER SEAT SENSOR

6572 ENGINE WARNING SYSTEM

575  LIGHT SWITCH FEED

576  LIGHT SWITCH TO RELAY

6577  FUSE PANEL TO CIRCUIT BREAKER

6§78 CIRCUIT BREAKER TO RELAY FEED

STANDARD WIRE COLOR CODE CHART (CONTINUED)

COLOR

WHITE-BLUE STRIPE
WHITE-RED STRIPE
YELLOW
YELLOW-RED STRIPE
BROWN

GREEN

BLACK-RED STRIPE
GREEN-WHITE STRIPE

BLACK-YELLOW STRIPE
RED-GREEN STRIPE
GREEN-RED STRIPE
YELLOW

GREEN

RED

GREEN-WHITE STRIPE
BLUE-BLACK STRIPE
GRAY
YELLOW-ORANGE STRIPE
YELLOW-BLUE STRIPE
BLACK

ORANGE

BLUE-RED STRIPE

RED-WHITE STRIPE
GREEN

YELLOW

ORANGE

GREEN

BLACK

BROWN

BLUE

ORANGE

WHITE
VIOLET-WHITE STRIPE
BLACK-WHITE STRIPE
ORANGE

BLACK

BLACK

YELLOW

WHITE-PINK STRIPE
BROWN-BLUE STRIPE
BLUE-WHITE STRIPE
GREEN-WHITE STRIPE
BROWN

ORANGE

BLUE

GREEN
ORANGE-WHITE STRIPE
YELLOW-GREEN STRIPE
RED-WHITE STRIPE
RED-BLACK STRIPE
BLUE

GREEN

YELLOW

CIRCUIT DESCRIPTION

579 RELAY TO JUNCTION BLOCK

580 FUSE PANEL TO ANTI-SKID

581 FAILURE MODULE TO RELAY

583 INTERMITTENT GOV. TO INTERMITTENT GOV. FEED

584  IGN. SW. TO SEAT BELT WARNING IND.

587 W/SHIELD WIPER SW. TO INTERMITTENT GOVERNOR FEED

588  W/SHLD. WIPER MOTOR DYN. BRAKE TO W/S WIPER SW. GRND.

589  W/SHLD. WIPER SW. TO INTERMITTENT GOV. GRND. DYN. BRKG.

590 INTERMITTENT GOVERNOR TO W/S WIPER SWITCH

591 SPEED CONTROL RELAY TO SPEED REGULATOR

592 STOPLAMP SW. TO SPEED CONTROL RELAY

593 SPEED CONTROL ACTUATOR TO CUTOUT RELAY

594 TEMP. TRANSMITTER TO IND. LAMP (ENGINE COLD)

536 PRIMER SW. TO OIL PRESSURE SAFETY SWITCH

597  COIL TERM. OF IGN. SW. TO OIL PRESSURE SAFETY SW.

598 COIL TERM. OF IGN. SW. TO FUEL PUMP PRIMER SWITCH

599  START TERM. OF IGN. SW. TO FUEL PUMP PRIMER SWITCH

600 FAILURE MODULE TO TANDEM RR. AXLE CONTROLLER

601 BRAKE SKID CONTROL MODULE FEED

602 COIL TERM. OF IGN. SW. TO BRAKE SKID CONTROL MODULE

603 DUAL BRAKE WARNING LIGHT TO BRAKE SKID CONTROL
MODULE

604 SKID CONTROL MODULE TO R. H. WHEEL SENSOR (HIGH)

605 SKID CONTROL MODULE TO R. H. WHEEL SENSOR (LOW)

606 SKID CONTROL MODULE TO L. H. WHEEL SENSOR (HIGH)

607 SKID CONTROL MODULE TO L. H. WHEEL SENSOR (LOW)

608 FAILURE MOD. TO FRONT AXLE CONTROL

609 ESOTP MODULE TO THERMOCOUPLE (NEG.)

610 THERMOCOUPLE (—) MODULE TO SENSOR

611  THERMOCOUPLE (+) MODULE TO SENSOR

612 AIR DUMP VALVE (-) TO MODULE

613 EGR VALVE (=)

614 SPEED SENSOR

615 FEED TO FAILURE SWITCH

617 FUSE PANEL TO SKID CONTROL MODULE

618 FAILURE MOD. TO RR. AXLE CONTROL

619 FAILURE MOD. TO RR. AXLE CONTROL

620 FAILURE MOD. TO RR. AXLE CONTROL

621 FAILURE MOD. TO FRONT AXLE CONTROL

622 FAILURE MOD. TO FRONT AXLE CONTROL

625 IGNITION SW. COIL TERM. TO PRIMER SWITCH

629 FAILURE MOD. TO RR. AXLE CONTROL

630 FUSE PANEL TO FAILURE INDICATOR RELAY

631 FAILURE MOD. TO TAN. RR. AXLE CONTROL

632 IGN. SW. COIL TERM. TO OIL TEMP. WARNING LAMP

633 IGN. SW. TO OIL TEMP. WARNING RELAY

634  OIL TEMP. WARNING RELAY TO OIL TEMP. WARNING LAMP

635 OIL TEMP. WARNING LAMP TO OIL TEMP. WARNING SWITCH

636 OIL TEMP. WARNING RELAY TO OIL TEMP. SW.

637 OIL TEMP. WARNING RELAY TO FLASHER

638 FLASHER TO OIL PRESS. SWITCH

639 FLASHER TO OIL TEMP. WARNING LAMP

640 IGN. SWITCH COIL TERM. TO WARNING LAMPS

641  IGN. SWITCH GROUND TERM. TO WARNING LAMP

642 WATER TEMP. WARNING LAMP TO WATER TEMP. SW. (COLD)

643 CHARGE INDICATOR LAMP TO SPLICE

COLOR

BLACK-ORANGE STRIPE
BLUE

GREEN-WHITE STRIPE
BLACK

GREEN-BLUE STRIPE
BLACK-WHITE STRIPE
WHITE-BLACK STRIPE
ORANGE

BLUE-WHITE STRIPE
BLACK-ORANGE STRIPE
BLUE-WHITE STRIPE

YELLOW

GREEN

BLACK

RED

RED-BROWN STRIPE
RED-BLUE STRIPE
BLUE-BLACK STRIPE
BLUE

RED-PURPLE STRIPE

GREEN

YELLOW

BROWN

YELLOW

BROWN

BLUE-WHITE STRIPE
RED

RED-YELLOW STRIPE
YELLOW

BLUE

BROWN

GREEN
BLACK-YELLOW STRIPE
BLACK-GREEN STRIPE
RED

GREEN-YELLOW STRIPE
BLUE

GREEN

RED-WHITE STRIPE
BLUE

RED-BLACK STRIPE
WHITE

GREEN-BLACK STRIPE
BLACK

RED

BLUE

GREEN

GREEN

BLACK

YELLOW
YELLOW-RED STRIPE
RED-YELLOW STRIPE
BLACK-RED STRIPE
WHITE-GREEN STRIPE
YELLOW-BLACK STRIPE



CIBCIT DESCRIPTION
644  OIL TEMP. WARNING LAMP TO IGN. SWITCH (ACCY. TERM.)
645 IGNITION SWITCH COIL TERMINAL TO TACHOMETER
646 TACH. THRU IGN. RESISTOR TO BATTERY TERM. OF IGN. COIL
647 WATER TEMP. WARNING LAMP TO WATER TEMP. SWITCH (HOT)
648 IGNITION SW. COIL TERMINAL TO TACHOMETER
649 TACHOMETER TO IGNITION COIL “B” TERM.
654 ALT. SHUNT “A” TERM. TO AMMETER
655 STARTING MOTOR RELAY SHUNT TO AMMETER
666 DOME LAMP FEED
668 IGN. RELAY TO STARTING MOTOR RELAY
669 IGN. RELAY TO STARTING MOTOR RELAY START TERM.
670 FAILURE INDICATOR TO MODULE
671 SPEED REG. SW. “ON" POSITION TO ON & OFF RELAY
672 SELECTOR SW. TO LEFT HAND PUMP MOTOR
673 SELECTOR SW. TO LEFT FUEL GAGE
674 SELECTOR SW. TO RIGHT HAND PUMP MOTOR
675 SELECTOR SW. TO RIGHT FUEL GAGE
676 L. H.SENSOR FEED JUNCTION BLOCK TO CONTROLLER
677 L. H.SENSOR COMMON JUNCTION BLOCK TO CONTROLLER
678 R.H.SENSOR COMMON JUNCTION BLOCK TO CONTROLLER
679 R.H.SENSOR FEED JUNCTION BLOCK TO CONTROLLER
682 H/L SW. BATT. TERM. TO TRACTOR—TRAILER RELAY “B" TERM.
683  H/L SW. “R” TERM. TO TRACTOR—TRAILER RELAY “F" TERM.
684 TRACTOR—TRAILER RELAY “A” TERM. TO MARKER LAMP SW.
685 TRACTOR—TRAILER RELAY CIRC. BRKR. TO AUX. MARKER
LAMP SW.
689 ENG. SPEED SENSOR UNIT TO MANIFOLD VACUUM SENSING SW.
690 HYDRO-BOOST SW. TO WARNING LAMP
691 SKID CONTROL MODULE TO AXLE SENSOR
692 SKID CONTROL WARNING RELAY TO SKID CONT. MODULE
693 BRAKE SYSTEM WARNING RELAY TO SW.
694 TURN SIG. FLASHER “P” TERM. TO TURN SIGNAL
IND. LAMPS
697 SPEED REG. SW. “OFF" POSITION TO ON & OFF RELAY
704 FRONT RADIO SPEAKER VOICE COIL GROUND
705 CIRCUIT BREAKER TO HEATER BLOWER SWITCH
708  RADIO SPEAKER VOICE COIL FEED
730 BATTERY TO VOLT METER
733 AMPLIFIER GROUND BREAKER LESS MODULE TO DISTRIBUTOR
734  AMPLIFIER TO SERVO TRANSDUCER FEED
735 AMPLIFIER FEEDBACK POTENTIOMETER FEED
737  AIR CONDITIONER MOTOR TO GROUND
738 FUEL PUMP RELAY “H” TERMINAL TO OIL PRESSURE SWITCH
739  FUEL PUMP RELAY TO SELECT SWITCH “B” TERMINAL
740  IGNITION SWITCH (COIL TERM.) TO FUEL PUMP RELAY
741 IGNITION SWITCH (ACCY. TERM.) TO FUEL PUMP RELAY
742 FUEL PUMP RELAY TO FUEL PUMP
743 FUEL PUMP RELAY TO OIL PRESSURE SW.
747  FUSE PANEL TO RADIO RECEIVER
748  A/C MODE SHIFT TO HEATER CONTROL SWITCH
749  RADIO RECEIVER TO F. M. TUNER FEED
763 ACC. TERM. OF IGN. SW. TO W/S WIPER CIRCUIT BREAKER
764  W/SWIPER CIRCUIT BREAKER TO W/S WIPER MOTOR
778  SEAT BELT SW. FEED “P” TERM.

STANDARD WIRE COLOR CODE CHART (CONTINUED)

MARKER LAMP SWITCH TO BLINK SWITCH

COLOR

RED-GREEN STRIPE
BLACK

RED

RED

RED

RED-GREEN STRIPE
YELLOW-BLACK STRIPE
RED-ORANGE STRIPE
RED

BLACK

RED-BLUE STRIPE
PINK

WHITE

BROWN

GREEN

BROWN-WHITE STRIPE
GREEN-RED STRIPE
ORANGE

GREEN

GREEN-WHITE STRIPE
ORANGE-WHITE STRIPE
YELLOW

BROWN

BLACK-WHITE STRIPE

BLACK-RED STRIPE
PURPLE
GREEN-WHITE STRIPE
YELLOW

BROWN

BROWN

BROWN
ORANGE-BLACK STRIPE
BLACK-RED STRIPE
BROWN
BLACK-ORANGE STRIPE
RED

BLACK-GREEN STRIPE
ORANGE-YELLOW STRIPE
PURPLE-BLUE STRIPE
GREEN
GREEN-ORANGE STRIPE
RED-YELLOW STRIPE
GREEN

RED

BLUE

YELLOW

BLACK

BLUE

BLACK

ORANGE-WHITE STRIPE
BLACK-ORANGE STRIPE
YELLOW

WHITE-BLACK STRIPE

CIRCUIT DESCRIPTION

780 ENGINE ALARM RELAY (OIL PRESS.) “F” TERM. TO “A"”
TERM. IGNITION SWITCH

781 BRAKE PAD SWITCH TO HOLDING RELAY

784 STEREO SPEAKER VOICE COIL RETURN

786 FUEL PUMP PRIMER SW. TO FUEL PUMP RELAY

787 FUEL PUMP SAFETY SWITCH TO FUEL PUMP MOTOR

789 VACUUM SWITCH TO HOLDING RELAY

795 NEUTRAL SAFETY RELAY TO NEUTRAL SWITCH

796  ACCESS. FEED TO NEUTRAL SAFETY RELAY

797 BATTERY FEED TO STEREO

804 FADER CONTROL TO FADER ARM (LEFT CHANNEL)

805 FADER CONTROL TO FADER ARM (RIGHT CHANNEL)

806 SPEAKER VOICE COIL FEED (RIGHT CHANNEL)

807 SPEAKER VOICE COIL FEED (LEFT CHANNEL)

808 SELECTOR SWITCH TO FUEL TANK SOLENOID VALVE

809 STOPLAMP SWITCH TO STOPLAMP

810 STOPLAMP SWITCH TO STOPLAMP

811 RELAY “A” TERM. TO TRAILER TAIL LAMPS

812 MARKER LAMP SWITCH TO MIRROR LAMP

813 BRAKE SWITCH TO TRAILER RELAY “B” TERM.

814  IGN. SWITCH COIL TERM. TO VOLTAGE RELAY

816 CIRCUIT BREAKER TO REVERSE RELAY FEED

822 FRONT SPEAKER TO FADER CONTROL SWITCH

823 FADER CONTROL SWITCH TO RADIO

824 FRONT SPEAKER TO RADIO

825  SERVO SOURCE VACUUM SOLE. TO CONTROL TRANSISTOR

826 SERVO VENT VACUUM SOLE. TO CONTROL TRANSISTOR

827 SERVO FEEDBACK POTENTIOMETER SIGNAL TO AMPLIFIER

828 SERVO FEEDBACK POTENTIOMETER BASE TO AMPLIFIER

829  IGN. SW. (ACCY. TERM.) TO VACUUM SOLENOID

830 SENSOR SIGNAL TO AMPLIFIER

832 CONTROL RELAY TO HOLDING RELAY

833  IGN. SW. ACCY. TERM. TO EMERGENCY STOP LAMP SW.

836 INDICATOR LAMP TO FLASHER

837 FLASHER TO EMERGENCY BRAKE SWITCH

838 THERMAL RELAY TO LOCK IN VALVE

839 BATTERY TO STOP LAMP CIRCUIT BREAKER

847 STARTER RELAY SOLENOID “SM"” TERM. TO C. S. RELAY
COIL

848 BALLAST RESISTOR “E” TERM. TO TRANSISTOR UNIT
“E” TERM.

849 STARTING MOTOR RELAY TO TACH BLOCK

850 BALLAST RESISTOR COIL TERM. TO IGN. COIL BATT. TERM.

851 TRANSISTOR UNIT “B"” TERM. TO DISTRIBUTOR

852 TRANSISTOR UNIT “C” TERM. TO BALLAST RESISTOR
“C"” TERM.

853  COIL TERM. IGN. SW. TO BALLAST RESISTOR “E” TERM.

854 C.S. RELAY TO STARTER SOLENOID 1" TERM.

856 TRANSISTOR UNIT TO PICK-UP COIL

856 PICK-UP COIL TO TRANSISTOR UNIT

857  TRANSISTOR UNIT TO START TERM. TO STARTER RELAY

858 MAKE READY SWITCH TO BRAKE PEDAL PAD SWITCH

859 BRAKE PEDAL PAD SWITCH TO CONTROL RELAY TERM. NO. 4

860 MAKE READY SWITCH TO SET SPEED SWITCH

861 RETARD SWITCH TO CONTROL RELAY TERM. NO. 7

COLOR

RED

BROWN

VIOLET

RED

RED-BROWN STRIPE
BROWN-WHITE STRIPE
RED-BLACK STRIPE
BLACK

GREEN

RED

BLUE

WHITE

ORANGE
BROWN-ORANGE STRIPE
RED-BLACK STRIPE
RED-BLACK STRIPE
BROWN

BLUE

YELLOW-BLACK STRIPE
WHITE

YELLOW-BLUE STRIPE
BROWN

GREEN

BLUE

GRAY-BLACK STRIPE
WHITE-PINK STRIPE
YELLOW-RED STRIPE
BROWN-GREEN STRIPE
RED

GREEN-WHITE STRIPE
YELLOW-BLACK STRIPE
GREEN

RED

BLACK
ORANGE-BLACK STRIPE
WHITE

WHITE

RED-WHITE STRIPE
BROWN
BLUE-WHITE STRIPE
GREEN

BLUE

RED-GREEN STRIPE
BROWN

VIOLET

ORANGE

WHITE

RED

YELLOW
VIOLET-WHITE STRIPE
BLUE-WHITE STRIPE



STANDARD WIRE COLOR CODE CHART (CONTINUED)

CIRCUIT DESCRIPTION
862 RESUME SWITCH TO CONTROL RELAY TERM. NO. 8
863 BRAKE SWITCH TO HOLDING RELAY
864 BRAKE SWITCH TO 20 M.P.H. SWITCH
865 SELECTOR SWITCH TO WARNING LAMP (LOW OIL PRESSURE)
866 CONTROL SWITCH TO OIL PRESSURE PUMP
867 IGNITION SWITCH TO OIL PRESSURE SWITCH
868 OIL PRESSURE SWITCH TO CONTROL SWITCH
869 RETARD VALVE TO CONTROL RELAY TERM. NO. 1
870 EMERGENCY STOP LAMP SWITCH TO TRACTOR—TRAILER PLUG
871 LOCK-IN VALVE TO CONTROL RELAY TERM. NO. 2
872 STARTER MOTOR RELAY TO CONTROL RELAY TERM. NO. 11
873 HEADLAMP SWITCH ““R” TERM. TO ASH RECPT. LAMP FEED
876 HEADLAMP SW. BATT. TERM. TO ALT. “A” TERM.
877 ALT.”F” TERM. TO REG. “F"” TERM.
878 REG.”A” TERM. TO IGN. SW. COIL TERM.
879 BLOWER SW. MED. NO. 1 THRU RESISTOR TO HI BLOWER
MOTOR FIELD
880 BLOWER SW. MED. NO. 2 TO LOW BLOWER MOTOR FIELD
881 20 MPH SWITCH TO CONTROL RELAY TERMINAL NO. 16
882 A/C BLOWER SW. TO A/C REFRIGERANT SOL. FEED
883 CIRCUIT BREAKER TO A/C CONTROL RELAY
884 A/C CONTROL RELAY TO A/C SW. (FEED)
885 ACCY.TERM. IGN. SW. TO A/C CONTROL RELAY
886 LAMP TO SENDING UNIT
887  SPLICE TO OIL TEMP. ENG.
888 W/SHIELD WIPER SWITCH TO RELAY
889 W/SHIELD WIPER SWITCH TO RELAY
890 W/SHIELD WIPER SW. TO RELAY
891  W/SHIELD WIPER MOTOR TO RELAY
892 W/SHIELD WIPER SW. TO RELAY
893 W/SHIELD WIPER MOTOR TO RELAY
895 IGN. SW. TO W/SHIELD WIPER MOTOR CIRCUIT BREAKER
896 IGN. SW. COIL TERM. TO IND. LAMPS, OIL PRESS. &
WATER TEMP.
897 CONTROL RELAY TO THERMAL RELAY
898 BRAKE SWITCH TO VACUUM SWITCH
899 ALTERNATOR NEU.-TERM. TO ALT. REG. (NEU.-TERM,)
900 ALTERNATOR AUX. TERM. TO IGN. SW. ACCY. TERM.
901 ALTERNATOR AUX. TERM. TO CHARGE IND. LAMP
902 ALTERNATOR RECTIFIER (+TERM.) TO LOAD
903 ALTERNATOR AUX. TERM. TO ALT. REG. FIELD FEED TERM.
904  (COIL/ACCY.)- TERM. OF IGN. SW. TO ALT. REG.
(IGN. TERM.)
905 AIR COND. SW. “MED.” TO BLOWER MOTOR
906 IGN. SW. (ACCY. TERM.) TO CIRCUIT BREAKER
907 HOLDING RELAY TO 25 MPH SW.
908 STARTING MOTOR RELAY TO LOCK IN COIL
910 BRAKE SWITCH TO AIR VALVE
911  FUSE PANEL (ACCY. FEED) TO SPEED REGULATOR SWITCH
912 SPEED REGULATOR SWITCH TO SELECTOR SWITCH
913 HEATER RESISTOR TO BLOWER MOTOR (HI)
914  FUSE PANEL TO SPEED REG. SW. FEED
916  SPEED REG. BRAKE SW. TO SPEED REG. COIL
916  SPEED REG. COIL TO AUTOMATIC CONTROL
918  IGN. SW. TO TRANS. NEUTRAL SW.

COLOR

WHITE-BLUE STRIPE
BLACK-YELLOW STRIPE
ORANGE

BLACK

BLACK

RED

RED-BROWN STRIPE
GREEN-YELLOW STRIPE
BLACK-WHITE STRIPE
RED-WHITE STRIPE
RED-BLUE STRIPE
WHITE-BLACK STRIPE
YELLOW

WHITE

GREEN

BLACK-ORANGE STRIPE
BLACK-RED STRIPE
GRAY

WHITE

ORANGE

YELLOW

WHITE

BLUE

RED

RED

GREEN

YELLOW
YELLOW-BLACK STRIPE
BLUE

BLUE-ORANGE STRIPE
RED

BLACK

RED

GREEN

RED

RED-GREEN STRIPE
YELLOW-BLACK STRIPE
BLACK-YELLOW STRIPE
GREEN-RED STRIPE

GREEN-RED STRIPE
BLUE

BLACK-YELLOW STRIPE
BLACK-ORANGE STRIPE
YELLOW

BLUE-WHITE STRIPE
ORANGE-WHITE STRIPE
YELLOW

YELLOW

GREEN

BLACK-ORANGE STRIPE
RED

GREEN

CIRCUIT DESCRIPTION

919 TRANS. NEUTRAL SW. TO INDICATOR LAMP

920 BRAKE SW. TO SPEED CONTROL REG.

921 SPEED CONTROL “OFF POSITION” TO SPEED REGULATOR

922 SPEED CONTROL ““ON POSITION"” TO SPEED REGULATOR

923 SPEED CONTROL SW. TO SPEED REG. SOLENOID

924 HOLDING RELAY TO SPEED CONTROL SW. FEED

925 SPEED CONTROL SW. TO SPEED REG. COUPLING COIL

926 HEATER BLOWER MOTOR SW. TO BLOWER MOTOR MED.

931 SPEED CONTROL SWITCH TO SPEED REG.

932 IGN. SWITCH TO THROTTLE SOLENOID

933 EMISSION MODULATOR CONTROL FEED

934 EMISSION SPEED SENSOR TO MODULATOR CONTROL

935 TRANSISTOR BASE TERM. TO DIST. TERM. OF IGN. COIL

936 TRANSISTOR EMITTER TERM. TO TRANSISTOR TERM. OF
IGN. COIL

937 EMISSION SPEED SENSOR GROUND

939 MODULATOR TO THERMO SWITCH

941 WASHER CONTROL SW. TO WASHER PUMP MOTOR FEED

943 TRACTOR TRAILER RELAY “B” TERM. TO TRACTOR TRAILER
CIRC. BRKER. LOAD TERM.

948 FLASHER TO R. H. LAMP

949 FLASHER TO L. H. LAMP

950 FUSE PANEL TO WASHER CONTROL SWITCH

951 WASHER CONTROL SW. TO WASHER PUMP MOTOR FEED

952 BATTERY TO TRACTOR TRAILER CIRC. BREAKER BATT. TERM.

953 COORDINATOR SW. TO W/SHIELD WIPER MOTOR

954  W/SHIELD WIPER SW. TO COORDINATOR SW. FEED

956  W/SHIELD WIPER MOTOR ARM RH TO W/S WIPER SWITCH

956 W/SHIELD WIPER SW. TO W/SHIELD WIPER MOTOR FIELD RH

957  W/SHIELD WIPER SWITCH FEED TO IGN. SWITCH

958 ACCY. TERMINAL IGN. SW. TO WASHER CONTROL SW.

960 AUX.HEATER FEED TO SWITCH

961 GLOW PLUG SW. TO GLOW PLUG WARNING LAMP

962 DIFF. TEMP. SW. TO FRONT DIFFERENTIAL

963 DIFF. TEMP. TO REAR DIFFERENTIAL

964 ALT. TO REG. FIELD CONTROL

965 RELAY (BATT. TERM.) TO BATT. CUT-OFF SWITCH

973 BATTERY FEED TO FUEL CONTROL VALVE

974 FUEL CONTROL SWITCH TO FUEL CONTROL VALVE

975 TRANSMISSION TEMPERATURE LAMP INDICATOR FEED

976  FUSE PANEL TO FUEL GAGE INDICATOR

977 BRAKE WARNING SWITCH TO INDICATOR LAMP

984 MARKER LAMP SWITCH TO MARKER LAMP

985 TURN SIGNAL RELAY TO LEFT TURN SIGNAL SWITCH

986 TURN SIGNAL RELAY TO RIGHT TURN SIGNAL SWITCH

987 TURN SIGNAL RELAY TO LEFT TURN CANCEL SWITCH

988 TURN SIGNAL RELAY TO RIGHT TURN CANCEL SWITCH

990 RELAY TO INDICATOR LAMP

993 INTERMITTENT GOVERNOR TO WINDSHIELD WIPER SWITCH

994 ELECTRIC COOLING P.V.S. SWITCH

995 HEADLAMP SWITCH TO LO-BEAM OF HEADLAMP

996 HEADLAMP SWITCH TO WORKLAMP

997 IMPLEMENT LAMP SW. TO IMPLEMENT LAMP

998 HEADLAMP SWITCH TO HI-BEAM OF HEADLAMP

COLOR

BLUE

YELLOW
GREEN-VIOLET STRIPE
WHITE

VIOLET

RED

WHITE-ORANGE STRIPE
RED-BLUE STRIPE
BLACK

BLUE

RED

BLUE

BLUE

BLACK

BLACK

GRAY

BLACK-WHITE STRIPE

GREEN

ORANGE

BLUE

WHITE-BLACK STRIPE
GREEN-BLACK STRIPE
YELLOW-BLUE STRIPE
WHITE-ORANGE STRIPE
BLACK-WHITE STRIPE
RED-ORANGE STRIPE
GREEN-ORANGE STRIPE
YELLOW

WHITE

RED

BLACK-WHITE STRIPE
RED

GREEN

BLUE

BLACK

RED

ORANGE

RED-GREEN STRIPE
BLACK-GREEN STRIPE
VIOLET-WHITE STRIPE
BROWN

RED

BROWN

RED-BLUE STRIPE
BROWN-BLUE STRIPE
BLACK-YELLOW STRIPE
BROWN-WHITE STRIPE
YELLOW

RED-BLACK STRIPE
YELLOW-BLACK STRIPE
BROWN-YELLOW STRIPE
GREEN-BLACK STRIPE
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11 | 12 | 13 | 14 | 15 | 16

1 | 2 | 3 | 4 | 5 | 6 | 7 | 10 |
- 33 v 33 Y =k HORN, HERN RELAY,
33 152 v 152 Y —4 REFERENCE @NLY SEE CHARGE START RUN,
Y [ 37 BK-Y 37 BK-Y =% REFERENCE @NLY SEE CHARGE START RUN.
152
$ Y C-206 383 R-W 4 EXTERIGR LIGHTING, EMERGENCY WARNING FLASHER
| .
=38 BK-R —FUSE LINK J—n BK-R == Yo
' §-201
C-207 ? ) ‘? c-2
o) g o2l 37 BK-Y
_J;f‘ STARTER g;,—--——‘ Bc-Ra
= MeTOR ‘---
— {12 vaLT RELAY 284 R 284 R 4 REFERENCE @NLY SEE EXTERIOR LIGHTING,
FUSE PANEL LBCATED IN GLOVE BBX = |BATTERY
®N R.H. SIDE @F DASH PANEL = = 19 BL-R
£-1 (20 ANP) HEATER 1:‘ - y
! ERTE ¢ C-205 A F-3 19 BL-R 4 TLLUMINATION LANPS. $-301,
C-208 | (2 AMP)
F-2 (14 ANP) BACK UP LAMP . RADID. F
TURN SIGNAL & WIND SHIELD WASHER s 40 BL-W 40 BL-W —% REFERENCE BNLY SEE PR@TECTION & CONVENIENCE.
K-¥
F-3 (2 AMP) INSTRUNENT PANEL ILLUNM
BK
F-4 (15 AMP ) DOME LAMP ¢ CIGAR LIGHTER /L 21 ¥ 0P
Lee
F-5 (20 AMP) EMERGENCY WARNING 4 §-202 A ¢-240 AMHETER
ST@P LAMPS = 37 ——285 BR 285 BR —%
L{ﬂ B 3 sh ——285 BR 285 BR —5 ' REFERENCE ONLY SEE EXTERIGR LIGHTING.
0 | TGNTTION Bx ——15 R-¥ 15 R-Y —
O ] |suitcH
g SWITCH
' [pesSITIONS 2y
04O | S-START
t-244 | R-RUN
-9 1| 8-oFF
”‘g\: A-ACCY
! ———30 BK-GR 30 BK-GR =% REFERENCE ONLY SEE CHARGE START RUN.
B - 783 8- 763 B8-H —4 WINDSHIELD WIPER WASHER, WINDSHIELD WIPER &
BK-6R | RO i ‘ KASHER SWITCH,
HEADLAMP d¢£-297 BK-GR § @-y ——=——————% EXTERI@R LIGHTING, TURN SIGNAL FLASHER.
SWITCH 5-202 137 Y-BK ——=————% RADI8, AM RACIO,
140 BK-R ————& EXTERIBR LIGHTING, BACKUP LAMP SWITCH,
297 F-2 8 a-v 950 W-BK ——————% WINDSHIELD WIPER/WASHER, WINDSHIELD WIPER &
C-408 BR-GR (14 AWP) 5-302 WASHER SWITCH,
F-1JL/’t> 399 BR < HEATER, HEATER BLBWER SWITCH,
(20 AMP)
297 BK-GR
1 I 2 | 3 I 4 [ 5 [ 6 I 7 I [ 10 | i1 [ 12 I 13 | 14 T 15 T 16
C-205 C-211 C-408
14401
14401 14401 1a40d 284 R
38 BK-R Q) @37 BK-Y 33 v ——54 GR-Y
14305 40 BL-W
REAR OF INSTRUMENT CLUSTER 25 BK-@
s (CT+38 BK 2 | 65 eR
14300 . 285 B
R
C-206 @r=-re0 19 BL-R
s STARTER MBTBR RELAY 15 R-y
14305 14401 R.H. FENDER APRON 53 BK-BL
37 BK-Y 37 BK-Y 53 BK-BL
904 GR-R 304 GR-R
18 BX.R o ocn |[€-240 SHERDLAMP SWITCH
BEHIND INSTRUMENT PANEL
BROWN 14401 RIGHT @F STEERING COLUMN
R.H. FENDER APRGN 4 GR-R
NEAR ALTERNATOR REGULATER 32 R?SL
32 R-BL
. 16 R-GR
C-207 21 ¥ GRBUND CBDES
s IGNITI@N SWITCH 6-202 8N ENGINE BLOCK NEAR ALTERNATER
14300 BEHIND INSTRUMENT PANEL
RIGHT @F STEERING COLUMN
s EQ3-RED
s BATTERY

PBSITIVE TERMINAL OF BATTERY -

C-208

14301

s E01-BLACK

8 BATTERY
NEGATIVE TERMINAL OF BATTERY

241
13927
©r-296 ®
. 14401
(C1=-297 BK-GR
s IGNITION SWITCH
BEHIND INSTRUMENT PANEL
RIGHT OF STEERING COLUMN

SPLICE C@DES

$-201 IN 14305 NEAR STARTER MBTBR RELAY

§-202 IN 144C1 NEAR TAKEQUT T@ IGNITI@N SWITCH
§-204 IN 14401 NEAR TAKE@UT T@ IGNITI@N SKWITCH
$-302 IN 14401 AT TAKEQUT T8 HEADLAMP SWITCH
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HE“TER caNTRoLS ILLU"INQ‘ION.I..'.z c13 RaaF LQ“P..IIOOCOC.lt'll.".ll.'..e Es DIST "oouLgToR “"BIENY.ll..l'll"l4 E13
AIR CONDITIBNER & HEATER 2 ALTERNAT@R o vuvseesesensonnssenonsed B2 | HI BEAM INDICATOR:cuesnoovnosnnveed E2 | STARTER MBTOR:veverrvvrnnvrvnnvennt 87 DUAL BRAKE WARNING:ooeuvovnenasooesd F2
81 “"P.l"..l‘.lIO‘IIIC‘&I‘I.I.IIIS Ba I/P ILLU"INATION.III.l."ll.llll.‘z C12 sThR‘ER "BTOR'Q.OUI.0.."‘.'0...!.3 as E"ERGENCY “nRNING.I..I"DQ....I.C'7 Es
CHARGE » START. RUN 3 90 AMP.usrenssssssssssssssassscsssd AD IGN SW 7/ W/S/W/WASHER ILLUMssoeees2 C11 TRAILER EXTERIBR LAMPS.vevusevvsse® DIl | EVAPORATOR THERMBSTAT .evusrvovsess2 DS
INTERIOR SWITCHesusssosssonssasess8 DI TRAILER EXTERIOR LAMPS.uuvosvsoneed D12 | FUEL TANK SELECT@ORueveseevooneoosed C7
EXIERIOR LISHTING 5 ‘ QHHETERIOOO|IIt..‘..!!.lll.lllll'l&a Es LIH‘ Bncxup.l.lllOl..ll‘ll.lC..l'.s Es TR“ILER E!TERIOR Ln"Psl..lll..l'l.s Dia HEQDLQHP..I.".I.ll'l..llll.....l.1 cs
L.Hl FRONT RQGF HARKER..IICIII.DIIG Fs HINDG“ REGUL“TGR SQFETVOIDOOOOQOlOZ B‘ HEROL“HPIl'.l'."'l.'l'.ll"..!l.'s 81
AMPLIFIER LeHe FRONT SIDE MARKER .uvssvsossssd D12 | WINDOW REGULATOR SAFETY.vvesneoese2 AB HERDLAMP v o v vvvvvoccsnsssssososnnse8 Bl
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1 | | 3 | 4 I 5 | 3 | ? | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16
37 BK-Y 37 BK-Y 37 BK-Y 37 BK-Y —~————=t EXTERIOR LIGHTING, SPLICE S-601.
G138 BK-R® —FUSE LINK ©——38 BK-Re r— 152 Y =————4 CHARGE START RUN, ALTERNATAR REGULATER,
! s-114 8-112 38 BK-R® ===t CHARGE START RUN. ALTERNAT@R,
¢k:::::::38 BK-R® —FUSE LINK AT - 37 BK-Y == EXTERIBR LIGHTING, TRAILER EXT. LAMPS RELAY,
| 22 BL-BK =—FUSE LINK ST 22 BL-BK ==& EXTERIBR LIGHTING, ELECTRIC BRAKE CONTRAL
~ 10 ——198 BK —@———198 BK ==FUSE LINK —O-- 431 R-W 491 R-W ===t PROTECTION & CONVENIENCE .RBBF LAMP RELAY.
cz/ﬁg; $-107 C-232 1C,B,(20 ANP) $-110
. v 883 @ FUSE LINK -o- 883 @ 4 AIR COND & HEATER, BL@WER MBTOR RELAY.
QO L‘Qyﬂv/" y——38 BK-RW =FUSE LIN{d’f’,,,, 2 2 38 BK-R® 655 R-@m ==& CHARGE START RUN, PRINTED CIRCUIT.
o D €212 Qremmmmmnty GAGES BNLY §-104 $-10%5 152 Y ammmmm—mt, CHARGE START RUN, ALTERNATBR REGULATER.
—Qy 0 QY O—1 —" €-233 38 BK-R 38 BK-R® =4 CHARGE START RUN, ALTERNATER,
! RED 37 agi 37 BK-Y 37 K-y 654 Y-BKS ———=t CHARGE START RUN, PRINTED CIRCUIT.
"/Qf?b ------- gnl/o\ BK-Y BK-Y >]/' 37 BK-Y $-106
&) L . Y 33 v 4 HORN & SPEED CONTRBL ., HBRN RELAY.
//CL/TQ: :Q¥“3\\\ ——g | [STARTER LINK  LINK 19 BL-R 19 BL-R ——=% ILLUMINATION LAMPS,HD/LP & IGN. SHITCH,
o . HBTOR Eoo (3 ERpT 19 BL-R ——5 ILLUMINATION LANPS, RAUIE,
o) :Q@’? 12 veLt RELAY $-101 @ $-101 b GAGES 54 GR-Y 54 GR-Y ———=t PROTECTION & CENVENIENCE, CIGAR LIGHTER @R
= { _J BATTERY e J(/,,—-—-—-—-—-- D@OR JAMB SWITCH R INTERIGBR LAMP SWITCH
FUSE 5 3 3 —
PANEL BK-Y  BK-Y 411 54
GR-Y
c-207 l
S HEADLAMP FOR ADDITIONAL H/D.LP.SW.CIRCUITRY
SHITCH SEE EXTERIGR LIGHTING PG.S
33 ¢ PROTECTION & CONVENIENCE PG.8
BK 37 A
BK-Y
C-411
$-102 53 BK-BL ——————=5 PROTECTIBN & CONVENIENCE, D@ME & CARGO LAMP @R DBOR JAMB SWITCH @R INTERIQR LAMP SWITCH
138 Q 6-101 285 BR ——————% EXTERIBR LIGHTING. SPLICE-503
F-1 (30 AMP) HEATER - 21 15 R-Y 5 EXTERI@R LIGHTING, HO/LP DIMMER SKW.,
Y 37 BK-Y 54 GR-Y ~
F-2 (3 ANP) INSTRUMENT PANEL & | 297 BK-GR ——— F=9 (15 AMP)
CLUSTER ILLUMINARTION /L 7[ 7 - 383 R-W = EXTERIBR LIGHTING., EMERGENCY WARNING FLASHER,
37 — F 820 AMP
F-3 (7.5 AMP) THROTTLE S@LENOID BK-Y C-302 7 840 65 GR < WINDSHIELD/WIPER & WASHER.W/WPR MBTOR
s 65 GR — WINDSHIELD/KIPER & WASHER, W/HPR SHITCH
F-B (7.5 AMP)
F-4 (7.5 AMP) SEAT BELT WARNING hij 8 8-y 4 EXTERIBR LIGHTING, TURN SIGNAL FLASHER.
. 140 BK-R ——————=& EXTERIBR LIGHTING, BACK UP LAMP SHITCH,
F-5 (BLANK) T F-11 (15 AMP)
: 181 @ ~ ATR CBNDITI@NER & HEATER, HEATER BLOWER SHITCH.
F-6 (7.5 AMP)  WINDSHIELD WIPER SYSTEM o— b---O C-237 Ve F-1 (30 AMP)
c-208 | >~ 297 BK-GR 5 137 Y-BK ————— RADIB, RADIB,PG.9-A3
F-7 (BLANK) ¥ €-237 : F-12 (7.5 aMpP) 297 BK-GR 297 BK-GR =4 CHARGE START RUN, PRINTED CIRCUIT,
;I_ IGNITIGN | ™ 30 BK-GR ———% CHARGE START RUN, RADI@ SUPPRESSION CHOKE,
F-8 (20 AMP] EMERGENCY WARNING = SHITCH | > >=——297 BK-GR
= |12 veL1 p : c-302 F-10 & 296 § —————% H@RN & SPEED C@NTROL ., SPEED SENSBR SWITCH
F-9 (15 AMPI COURTESY LAMPS = |BaTTERY S SITCH | 1 * 297 (20 AMP) !
= |rauxrizary)  LOC POSITIONS ) BK-GR 297 BK-GR &——297 BK-GR <{§;Zj§}-297 BK-GR — S HORN & SPEED CONTR@L. SPEED CONTROL AMPLIFIER
F-10 (20 aMP} ACCESSBRY FEED T- S-START ; c-719 !
% R-RUN , O ké-**—r—j IN-LINE
. . . 0-0FF ! FUSE
F-11 (15 AMP) BACK-UP LAMPS & TURN I C-207 aoacey | 1&g 5-103 297 BK-GR (s e
SIGNAL FLASHER R 640 R-Y ——% CHARGE-START-RUN., THRBTTLE ACTUAT@R
BK 2 640 R-Y 932 BL ~ CHARGE START RUN, EMISSI@N CONTROL SBLENRID,
F-12 (7.5 AMP) RADID xk ' F-3 (7,5 AMP)
Q 6-101 584 GR-BL — ~5 SEAT BELT WARNING
F-4 (7.5 AMP)
1 I [ 3 [ 4 I 5 6 I 7 [ 8 [ 9 [ 10 I 11 [ 12 | 13 I 14 | 15 l 16
C-206 C-232 €-302
14401
14300
134709
s EQHRED . 98 BK
491 R-H %
POSITIVE TERMINAL BF BATTERY . G{T‘ 297 BK-6R
» BATTERY . 32 R-BL
R.H. FENDER APREN b0 Ren
€-207 ® CIRCUIT BREAKER (20 AMP,) 2V .
14301 SRAY
s E01-BLACK L.H. SIDE @F
NEGATIVE TERMINAL OF BATTERY [ C-233 INST. PANEL
» BATTERY L4401 14305 SIGNITION S4ITCH GROUND CODES
L 37 BK-Y a1l 6-101 EYELET ATTACHED T8 R.H.SIDE ENGINE BLOCK
C-212 37 BK-V 37 BK-Y 14401
. 37 BK-Y 37 BK-Y 54 GR-Y
14305 25 BK-8
(Cr=+38 BK-Rs . 54 GR-Y
285 BR SPLICE CBDES
14300 15 R-Y
©C1-rReD C-237 19 BL-R $-101 IN 14401 NEAR STARTING M@T@R RELAY
53 BK-BL $-102 IN 14401 NEAR T/@ TO EMERGENCY WARNING FLASHER
14 4 -
s o s pimo I e pe et s
37 BK-Y R CRASH PA .
: CLF-37 k- UNDER CRASH PAD 5-105 IN 14305 NEAR T/8 10 STARTING MBT@R RELAY
38 BK-Rm 8 HEADLAMP SHITCH
s 14401 14A303 $-1086 IN 14305 NEAR T7/0 T@ 14401 ASSY
§-107 IN 144303 NEAR STARTING NBT@R RELAY
G137 BK-v C1 198 s ERLEL PP 5-108 IN 140303 @R 144346 NEAR STARTING N@T@R RELAY
. 14300 $-109 IN 140303 B8R 140346 NEAR STARTING M@T@R RELAY
144303 296 R ——) L4401 $-110 IN 14R480 NEAR STARTING MAT@R RELAY
@198 B CL T-reo 90840 s-111 IN 14305 NEAR STARTING M@T@R RELAY
140303 30 BK-GR 5-112 IN 14305 NEAR T/@ T8 STARTER MOT@R RELAY
140480 297 BK-GR—®) 297 BK-GR
©}—297 BK-6R ELECTRICAL SYSTEMS 1976 ECONBLINE
(Ctr-883 @ ACCESSBRY SAFETY RELS 144303 POWER DISTRIBUTION
R.H. FENDER APREN LAY 297 BK-GR—@®) EFFECTIVE P.C.R.
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1 | 2 | 3 | 4 | 5 | 6 | ? | 8 9 | 10 1 11 | 12 | 13 | 14 | 15 | 16
C- 1101 &C— 883 @ To11L3
POMER DISTRIBUTION. SPLICE S-110. ¢ 863 0 < 883 @ 130885 190885
883 @ ! POKER DISTRIBUTION, FUSE PANEL (F-21,PG.1-814 S—19 BL-R 347 BK 347 BK
. POMER DISTRIBUTION. FUSE PANEL (F-1) $——181 ac-““ 1 884 T:: £-1102 348 GR-ye @3“ or-ue
Y
J,/f/o_] PONER DISTRIBUTION, FUSE PANEL (F-21,PG.1-B14 $—19 BL-R GREEN
\ M
W
181 @ 181 a-\r T ¢-1102 : RE:SS:TOR
- 181 @ — — SAFETY i3 NEAR T/8 BLBWER MBTBR GRAUND
— 181 @ > 181 @ 753 Y-R C-1118 RELAY 19 BL-R
‘ I’ C-239 [————————994 v—— 888 l_‘l ! | T /¢ meDE SWITCH C-1114 190885
SHITCH 0 t-1108 —_— - L c-315
I PRSITIONS AuX. C-1102 £ 713 , ° (BLOWER M@TOR RELAY) 19 BL-R >> 19 BL-R Ty s [4-348 Gr-us
8 1. OFF | 5| asc aH L o 753
181 2. Lo CONTROL -—o\\J> 738 000 Y-R c-901 surtew [ 347 8K
3. MED 1 2?3?‘? SKITCH ! 1 19 19 A
4, MED 2 (BLBHER ) 1 C-1118 N c-1118 BL-R BL-R oL (T R
5. Wl Ll ZLREEE ) C-514 T R.H. SIDE BEHIND INST. PANEL
_ ¥ C-1103 : €c-1102 T N s c-211 Bt?ﬂ 19
T c-1107 209 . [ A N OR 3 c-513 BL-R €-1115
SHITCH BL = < ‘ C-301 194885
POSITIONS HEATER o288, 269| B NINDOW 753 Y-R 4 ——————268 R-BKa l - STERE® TAPE/ Bk @ ©-347 8K
1. BLAMER BL REGULATER )\ 15 19 RADI0 AM/EM/MPX
c 2. LBN pﬁp SHITCH SAFETY C-11186 BL-R BL-R BL-R P.C. BL-R RADIO NEAR A/C COMPRESSER
3. MED L RELAY SWITCH T RECEIVER RECEIVER IN ENGINE CMPARTMENT
4. HI C-1104 - C-1104 PASITIONS A/C = =
( R NOTOR RELAY) 48 GR-HE —— = = PART OF
c-1107 2?9 BLOWER NBTOR REL [-‘~‘3 8 GR-Wa Lo CONTROL HOLP/1GN/ HEADLANP 16N SWITCH/ WEATER » PART @F A/C CLUTCH SBLENEID
R BKa 269 C-1113 2. NED LBHL SNITCH W/S/W/WASHER SWITCH W/S/W/WASHER I/pP PRNOL CONTROLS
269 BL 3. WED W1 2?3?4? BLOKER ) 3 ) centroLs ILLURINATIEN 3 ) contreLs C—Dmunmauon ILLUMINATION C-D TLLUNINATIGN F@R ADDITIBNAL RADI® CIRCUITRY C-1118 190885
] 268 BL 289 270 ’ ILLUMINATI®N Lanp TLLUMINATIEN LAMP LAMP SEE RADI@ SYSTEM PG, 9
270 L BK-Y 348 4. Hl \LJ‘J’, LaMpP LAMP = LAMP 270 BK-
R-BK= BK-Y __J(__ __7L GR-We 884 C-1118 By
SIHR-SRRIIH €-1105 Y HEATER-A/C
T T l 269 BL 57 P.C 37 BLOKER wmm 269 BL
= 270 . 57 57 T BK SWITCH 268 R-BKm
0 TT7 c-1108 29 | kv p 269 8L BX BK B 269 8L
270 BK-Y
R 269 EVAPaRATOR ,4-“--,[__,[ i c-211 BEHIND A/C CENTROLS
270 -Bks | gL ) g THERMBSTAT AR A A AR ML N C-513
BK-Y L__*__?L__ SWITCH T T7T L y J c-301 C-1117
] il PR R e (A/C CLUTCH) e o514 194885
M@TOR \L c-1114 WITHOUT WITH 57 57 269 BL
RESISTOR —> > Y BK AIR COND. AIR CBND, BK 8K 884 v
C-1109 BK 347 268 R-BK®
T BK BLOWER NETOR S7 BK ——b CHAR a/C 2270 BK-Y
J{ x] GE, START, RUN, *
: C-1113 RESISTOR 57 8K ENGINE SPEED SENSBR PG.4-F15 BLOWER 269 8L
BLOWER M@TOR AUX.HTR. T BLOKER MOTOR
RESISTOR oR A/C 347 NeTeR 57 BK 57 BK 57 BK ——5 CHARGE START RUN, IGNITIGN RESISTOR o
BLONER BK 5-201 SWITCH BACK PLATE PG.4-F2 O--- 3¢
BK HBTOR J\ ] 8 PART @F BLBLCR M@/ 2R
] C-1115 8K 57 BK —=5 WINDSHIELD WIPER WASHER, R.H, SIDE STEERING COLUMM
/l\ \L 57 WINDSHIELD WIPER WASHER SWITCH, T1110
Lo, gi( C-1110 BK OR GOVERN@R PG.3-F15 198885
; BLOKER T 1 asc A/C NWITH BR T a/C 753 Y-R
MO TOR 3; H CLUTCH HITHBUT AUX.HTR, 8; HBDE s 753 Y-R
SBLENSID 0 6-203 SKITCH 181 @
e A _ 4L - 348 GR-Hm
Q 6-201 ; Q §-202
1 | 2 [ 3 [ 4 [ 5 I 3 I 7 T 8 3 | 10 I 11 T v I 3 I I3 I 5 l G R.H. SIDE STEERING COLUMN
C-315 c-1101 C-301 C-514 ¢-1103 C-1106 C-1110 C-1111
138743 19949
19A885 57 8K ok ionene 269 BL
19 BL-R ! 268 R-BK= 194885 @R
883 @ 14401 19949 188604
883 8 57 BK GREEN 14401 AUXILIARY 270 BK-Y AUXILIARY 270 BK-Y
. E‘?f-i 19 BL-R 57 BK A/C-HEATER 269 BL BLBKWER 269 BL OR 13A885 14401 @181 e
BROKWN 144480 H+39 R-W 138743 FAN [ ] 269 BL MOTOR »
283 v-BK o2 wsie o0 BK 19 BL-R i 268 R-BKE RESISTOR - 181 e—fm] < 18604
385 W-R 883 0 oBE3e sropr 304 GR-R 57 BK 19 BL-R 884 v [0} 8k axJ[E] [cz"r}?—sr 8K o1 o
LVoiy 188604 . ] 297 Be-GR 37 BK GREEN ws PART OF BLOWER M@TOR BROWN BROWN vt
- BROWN 31 noge S GR-K 19 BL-R
282 GR 883 @ o977 poyw 48 BK 19 BL-R NEAR T/@ M@DE CONTROL SHITCH R.H. SIDE UNDER I/P
2 u-BLe BREY 1440 bff6e0 R-y 0 BK-ER GREEN eraer GRAY
3 GR-W ! BRWN ! i 188604 * PART OF BLOWER MATOR NEAR T/@ A/C M@DE CONTROL SWITCH
R-BK - 286 @ .
810 R-8 283 v-BK NEAR T/8 HTR & A/C BLWR MTR RELAY LeMe SIDE BF STEERING COLUMN 1M 1i0a 270 BK-v
44 BL 385 H-R GRAY HEATER
19 BL-R BLOWER = 269 BL
19 BL-R BEHIND INSTRUMENT CLUSTER c-301 igee04 1
1 BL-Y PRINTED CIRCUIT I ] 14401 190605 ok 130885 e 268 8
282 ok c-211 C-239 . CIRCUIT (W/@ GRGES) 270 BK-y 270 BK-y 288 R-BKs» GRBUND CRDES
94840 GREY 2 W-BLE 13 8L-R 269 BL 269 BL BEHIND HEATER CONTROLS 6-201 NEAR BLBWER MBTOR
283 ¥-BK 3 6R-N 14401 127%::(:@ 127%::“ 268 R-BK» 268 R-BK® IN 19949
385 W-R 3 GR-H -] c-1108 6-202 NEAR BLOWER M@T@R
190605 188604
- 2 W-BLs ® 31 W-Rs . UNDER I/P. REAR @F RADIB 188604 IN 19A885
19 BL-R C-513 R 19
1 BL-Y 810 R-BK ® 0977 P-us " PART OF RADIO B8R 134883 269 BL 6-203 R.H. SIDE BEHIND INST. PANEL
282 6R 44 BL ® D—640 R-¥ 188604 188604 269 BL ‘-@ 269 BL BLOWER 268 R-BKs IN 14401
2 u-8Lm BREY B0T—286 8 o g SR MateR w® 270 BK-Y
3 GR-N o | @030 BKGR Lo b 181 G‘E\%‘im 0 . Laa01 1 RESISTER 2 oy SPLICE CBDES
810 R-BK ﬁ:isg“;’.‘a. 2 W-BLw BRav 19 BL-R 19 BL-R 188604 ’ §-201 IN 14401 NEAR T/8 T8 HO.LP.4 IGN.SH.ILLUM,
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CONNECTOR C-521 CHGE.START.RUN- PG,7-A7 599 R-BL I 39 R Nl v6c BN L.H. FUEL TaNK
CONNECTOR C-521 POWER DSTR,- PG.1-A11 9=69 R-GR 1 O—————""69 R-GR 599 597 5
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43 9-BL 44 PN ) N C-626 BK 2 SPEED
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¢-502 A AT AIR SYSTEMS RECEIVER PARK
c-527 -3 DuAL 5? BNLY SPEAKER MoTeR
BRAKE oL Bk BL  rRansHISSION c-628 o
LOW AIR Lo AIR WARNING WARNING TEMPERATURE oIL -
PRESSURE PRESSURE SHITCH : NARNING TEMPERATURE
SWITCH SHITCH _ SKITCH Py INDICATOR TENPERS
- - = = ~ = . BK LAMP SHITCH
HYDRAULIC @NLY aIR over wypraur1c ©°7°03 6-603
1 I 2 ] 3 | 4 I 5 I 3 I 7 8 3 T 10 [ 11 I 12 [ 13 I 14 [ 15 { 16
t-524 [C-626 C-503 C-524 -528 C-616 ) 108920 C-621 C-628
78379
JUNCTI@N BLOCK 28325 14401 buAL 28325 57 8k 57 8K 12 2-5L-@ oIL 108939
O] 977 P-H 977 P-W BRAKE 977 P-W 42 R-W 42 R-W 14401 TEMPERATURE 55 gy
977 P-u 977 P-# WARNING 977 P-M s ©-32 R-8L WARNING
o 977 P-W SHITCH BEHIND I/P, L.H. SIDE 14A31 SHITCH
DI@DE = »
© 14401 28325 e BEWIND I/P, L.H. ® LBN VACUUM WARNING LANP ¢ @ ON SIDE 8F TRANSMISSION HOUSING
o @-977 P-u CENTER @F CLUSTER == BEWIND CENTER OF I/P
(10B933) BK -c:x@\v/@r}aes BL (14A313) :;; g:@ @g;; ::: LEFT HAND SIDE OF 178587
(14674)% 143 R -<E@\ /(@D-ua R"(14665) INSTRUMENT PANEL T-529 65 GR c-622 ¢-801
(146741 %% 142 &R -CTOTOF-(OT-142 GR "™ (14668 76203 Len313 N/“SIP;IEERLD . o . 78379 150404 14401
(14674) 141 8K -CTO1O-(CT-141 BK (14665 BR 14668 @:g;; i: YL ©-74 &R HoTeR 48 BK 32 R-BL 32 R-BL :3 :ﬁgt
D . 32 R-BL 32 R-BL . -
69 R-6R IO (94350) 675 GR-R —CLOHO-(CI 675 GR-R (9A342) Lar313 10C924 = 100E @74 o LW, SIDE OF ENGINE COMPARTMENT 8 _ 53 BK-8L 307 BK
140 BK-R 140 BK-R 207 BK
(90350 %%% §74 BR-N L0t —(CT 674 BR-H "**% (3A342) BEHIND I/P, CENTER BF CLUSTER R 207 8K
140A997 1 896 BK -EZ@ 114401) (94350 ) "s88 787 R-BR -@, \@:’787 R-BRUSEE (91347) 87846 GBRL oL LEFT HAND SIDE ©F C-518 : 140 BK-R 140 BK- 137 Y-BK 137 y-8K
(140313141 8-y IO G 3 ER-Ritaa0r (3a342) "*%% 787 R-8R TTOY 4 a1 BK-Y @:BK INSTRUMENT PANEL 178587 BEHIND R.H. SIDE OF I/P BEWIND I/P, L.H. SIDE
16 R-6R (30350} 673 GR \@:_573 GR (9R342] C-504 » PART @F START/NEUTRAL SWITCH
(108846 41 BK"¥ 142 GR (14568 —D::/QYO;[D" 28325 # TRANSMISSIGN TEMPERATURE C-614 H/“S[HPIEERLD 23 :-0
- - { ) - ]
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(983421539 R-BL _{3@ 32 R-BL (14401 BEHIND PASSENGER SEAT. QUTBBARD SIDE ng:';is . ,@ﬂ, 56 BL
599 R-BL 114401 ® 2 SPEED AXLE, ELECTRIC SHIFT o457 BK 57 BK L.H. SIDE BF ENGINE C@MPARTMENT 6-503 IN 38325
(1348851 §9 R-GR s 2 SPEED AXLE. AIR SHIFT SWITCH ¢-528 58 W-8 §-602 IN 178587, ATTACHED T8 L.H. SIDE COWL
JUNCTIBN BLOCK BEHIND I/P, L.H. 14401 63 R C-619 6-603 IN 104920, ATTACHED T@ L.H. SIDE COHL
BEHIND /P, NEAR CENTER mee DUAL TANK W/EL. PUNP CENTER OF CLUSTER W/SHIELD 61 ¥ 78379
wass SINGLE TANK H/EL. PUMP 977 P-W 8] '« WIPER  ® 65 GR 32 R8L-0 4401
. NOT USED SWITCH 57 BK SPLICE C@DES
C-520 763 8-W 14a313 @32 R-BL
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BROKE 14401
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PRESSURE »  2K146 sa:rgw 43 8-BL 977 P-H 977 P-W "PRESSURE s [B}-43 8-8L 104920 ELECTRICAL SYSTEMS 1976 L-SER (CITY DEL)
HARNING 43 0-BL 977 P-4 GRAY SHITCH LB VACUUM [}-42 R-W C-620 CHARGE , START, RUN
BUZZER 977 P-M LOWER R.H. SIDE @F DASH., WARNING = 14401 14401 EFFECTIVE P.C.R, RADIO
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BEHIND I/P, NERR CLUSTER ® DUAL BRAKE WARNING LAMP AT TOE BBARD a1 -30-75 TRP@ ELECT INST MAN PAGE E6H-900-7
L.H. SIDE BF ENGINE C@MPARTMENT BEHIND CENTER 8F I/P DATE 10 A
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SPLICE $-803 EXT.LIGHTING- P&.9-E4 S——810 R-BK U, o
(1] 14401
. - - - 383 R-N 383 R-W
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BK S 1004 PROTECT-‘ CBNV.‘ PG.10~913 9 ? evERRIDE’ (H/B BRAKE BEH[ND CLUS'ER-L.“. SXDE
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JUNCTI@N BLOCK JUNCTI@N BLOCK  y4405 HILR.RHB.R 178720 RBRVE NRIONOUFSH"I:RLKDE;SLQP"LPMES'
JUNCTION BLBCK — . ;
T 852 BL -LTO){O}(CTI-852 8L (13405) 283 v-8k —TO){O}(OT-283 v-8BK MarkER ® LI 57 BK
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—TO)tot T+ (14305) 31 H-R —T0)40+(CT3-31 W-R (14401) (13404) 285 BR -CLO) ® 0
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JUNCTIBN BLoCK (14a341) 284 R -CTO)OF(OT3-870 BK-H (14401) 286 0 286 @ 15438
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BEHIND PASSENGER SEAT IN ENGINE C@MPARTMENT, ON HOBD INNER PANEL, R.H, SIDE BEHIND I1/P» L.H. SIOE DATE 10-30 SERVICE AND TRAINING MAN PAGE
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l___‘ SNITCH }__‘ SWITCH SWITCH l__4 SWITCH Ui PRESSURE (L/o—J BRAKE R
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WITH 810 R-BK Aoy INTERLOCK o) BACKUP
810 am R-BK O p Q anp
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[ 5-805 ' ' 140 c-623
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R-BK PG.7-E7 i
TERMINAL GRBUNDED 284 ]
810 INTERNALLY T@ R !
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911\ 140 BK-R —O-—{B]--0—140 BK-R
L.H, R.H.
c-821 BACKUP BACKUP
P LAMP
T8 Le
TRAILER - -
WIRING
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C-221 C-625 c-817 c-821 .
JUNCTIEN BLOCK JUNCTIBN BLBCK 14405 138612 1 283 v-BK
852 BL —TL0){O} (CT3-852 BL (13405) 283 v-Bk —T0)-{O} (OCT3-283 v-BK STopLaNP S1—810 R-BK 212 BL
851 GR o} 851 GR » @O _ X
848 R-W -_L0)10+(CT3-848 R-H 113404) 282 &R LTO)0r (CT-282 &R SWITCH o284 & TRAILER 2078
(134051 285 B8R — o= 206 W
+10) o Cr=+ (134041 285 BR -C10)— | 285 BR 8N BRAKE PEDAL SUPPBRT PLUG 285 BR
(14305131 W-R 1ot 31 K-R (14401) ) ) 282 GR
(14305) 39 R-W—CTL0)—1Ot— 39 R-W (14401) (13405) 140 BK-R LTO) O} @140 BK-R 284 R
(10A398 @R 14305145 Y-R —T0){Or(CT 45 v-R (13404) 140 BK-R —TDO) C-818 BEHIND CaB
(10A998 @R 14205) 17 W—LO)—+tO+—(OT317 W
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0 R-B (OT3-810 R-BK (14401) ¢-820 148371
810 #-8k =IO) J 81 14401 15436 140341 810 R-BK » ©rr212 8L
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207 BK @D‘J
C-624 283 Y-BK o —207 BK
JUNCTION BLOCK 284 R 283 v-BK IN ENGINE COMPARTMENT, SROUND CODES
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1
(14405) 283 Y-BK 4:@—0-@:}—233 Y-BK (14401} 42 R-BL 32 Rl C-816 SHITCH 284 R $-805 IN 130411, NEAR TAKEGUT T@ JUNCTION BLOCK
(14405) 282 6R —T0)+O{ (CTH282 6R (14401) 32 R-BL 32 R-BL 134612 14401 ELECTRICAL SYSTEMS 1976 L-SER (CITY DEL)
EXTERI@R LIGHTING
(14405) 140 BK-R -CT0)Ot(CT-140 BK-R (78379 BR 15525) 1:8 gﬁ'z ;:g g:': 810 R-BK ggsm R-BK ©1—870 BK-u EFFECTIVE P.C.R
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INTRODUCTION

The Why and Wherefore of Wiring Diagrams

To the uninformed, a wiring diagram — or a wiring assembly —
looks like it might take a genius to figure out.

Not so — as you'll find out when you get better acquainted with
these subjects.

There're as understandable and logical as a road map and road
markers, when you're finding your way on a cross -country drive.

The ability to read a wiring diagram and relate it to a vehicle's
wiring system is, of course, an essential part of a modern service tech-
nician's skill. And it's growing in relative importance, too, due to
owner's increasing demands for the comforts and conveniences supplied
by electrically - operated options and accessories. This opens up greater
opportunities, for the forward -looking technician.

The Purpose of this Booklet . . .

. is to acquaint you with the systems by which electrical circuits are
traced on vehicles. Specifically, it is designed to help you acquire the
ability to make your own power checks, quickly and accurately.

Scope of the Booklet

Basically, this is a printed version of the film, "How to Read a
Wiring Diagram.” It is in no sense a manual of the shop methods by
which electrical repairs are made.

It can be a helpful guide that can introduce you to the principles of
wiring diagrams and vehicle wiring. As you gain experience in reading
wiring diagrams, you'll accumulate your own know-how in this impor-
tant skill. When it becomes "second nature" to you, these pages will
have served their purpose — and yours.



To show how to read wiring diagrams — and
to explain how they can be used to help you
troubleshoot problems in the electrical system —
is what this booklet is all about. Obviously, these
are important subjects.

If a customer comes in because his headlights
aren't working, you can't just make a snap deci-
sion. That's not the professional way.

Putting in a new sealed-beam unit may be the

answer ... but then again, it may not. Snap
decisions are out. They're not professional.

When you go to a doctor, for example, he tries
to find out what's really wrong with you. He looks
beyond the aches and pains you feel, to see what's
causing the trouble. We call this, diagnosis.

diagn
docto
troub
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